HP Jornada
420 Palm-size PC

User’s Guide

Part number F1255-90002
Printed in Singapore
Edition 1
Copyright notice

This manual and any examples contained herein are provided “as is” and are subject to change without notice. Hewlett-Packard Company makes no warranty of any kind with regard to this manual, including, but not limited to, the implied warranties of merchantability and fitness for a particular purpose. Hewlett-Packard Co. shall not be liable for any errors or for incidental or consequential damages in connection with the furnishing, performance, or use of this manual or the examples herein.

The above disclaimers and limitations shall not apply to consumer transactions in Australia and the United Kingdom and shall not affect the statutory rights of consumers.

© Hewlett-Packard Co. 1999. All rights reserved. Reproduction, adaptation, or translation of this manual is prohibited without prior written permission of Hewlett-Packard Company, except as allowed under the copyright laws.

The programs that control this product are copyrighted and all rights are reserved. Reproduction, adaptation, or translation of those programs without prior written permission of Hewlett-Packard Co. is also prohibited.

Microsoft, MS, ActiveSync, Active Desktop, Outlook, Windows, Windows NT, and the Windows logo are either registered trademarks or trademarks of Microsoft Corporation in the United States and/or other countries. Microsoft products are licensed to OEMs by Microsoft Licensing, Inc., a wholly owned subsidiary of Microsoft Corporation.

CIC and Jot are registered trademarks or trademarks of Communication Intelligence Corporation.

BSQUARE and bTask are either registered trademarks or trademarks of BSQUARE Corporation. OmniSolve is copyright 1998-99 LandWare Inc. with all rights reserved. LandWare is a trademark of LandWare, Inc.

EZOS, EZOS EzExplorer, EzExplorer are either registered trademarks or trademarks of EZOS S.A. in Belgium and/or other countries.

Hewlett-Packard Singapore (Pte) Ltd.
Asia Pacific Personal Computer Division
452 Alexandra Road
Singapore 119961
# Table of Contents

**Chapter 1 Welcome** .......................... 1
- Taking inventory .................................. 1
- Using the manual .................................. 2
- Using HP Jornada’s built-in programs .......... 3
- Finding more information ....................... 5
- Registering the HP Jornada ..................... 6
- Understanding conventions ..................... 6

**Chapter 2 Setting up** .......................... 7
- Identifying the hardware features ............ 8
- Setting up for the first time ................. 11
- Managing battery power ....................... 16
- Caring for the HP Jornada .................... 20

**Chapter 3 Learning the basics** .............. 21
- Turning the HP Jornada 420 on and off .... 21
- Locking the hardware buttons ............... 22
- Using the hard icons ......................... 22
- Using the Active Desktop .................... 23
- Using the Start Menu and taskbar .......... 24
- Using the command bar ....................... 25
- Typing, writing, and drawing on the HP Jornada .... 25
- Finding files and documents ............... 28
- Finding information ....................... 29
- Viewing information ....................... 29
- Adjusting settings ......................... 30
- Using HP settings ......................... 31
- Learning the shortcuts ..................... 36

**Chapter 4 Connecting to a desktop PC** .... 39
- Connecting for the first time ............ 39
- Connecting and disconnecting ............. 46
- Connecting by infrared ...................... 47
- Connecting to another PC .................. 48
- Browsing the HP Jornada desktop .......... 49
- Synchronizing data ....................... 50
- Using channels ......................... 52
- Transferring files ....................... 54
- Printing ...................................... 54

**Chapter 5 Sending and receiving e-mail** .... 55
- Synchronizing messages ............... 55
- Using Windows CE Inbox Transfer ........ 56
The Hewlett-Packard Jornada 420 Palm-size PC (P/PC) is a mobile computer running the Microsoft® Windows® CE operating system. It allows you to store your business and personal information, manage your appointments and contacts, and check e-mail while on the road. It then allows you to upload updated information to your desktop or notebook PC after returning to the office.

In addition to Microsoft Windows products, the HP Jornada has built-in programs from Hewlett-Packard, BSQUARE™, and LandWare that help you manage the system, manage tasks, and perform financial calculations. It also allows you to load programs from the HP Jornada compact disk.

This chapter includes the following:

- An inventory list of the HP Jornada package
- A description of the contents of this User’s Guide
- An overview of built-in programs

**Taking inventory**

The HP Jornada package includes the following items:

- HP Jornada 420 and stylus
- HP Jornada battery
- AC adapter, DC cable, and power cable
- Sync cable
- Cradle
- HP Jornada Quick Start Card—A guide to getting started quickly with the HP Jornada
Desktop Software for Microsoft Windows CE compact disk—Contains Microsoft Windows CE Services, plus software and system updates for both the HP Jornada and desktop PC

HP Jornada compact disk—Programs that can be loaded onto the HP Jornada

Documentation pack—This User’s Guide and the Regulatory Information Leaflet

HP Jornada Accessory Guide—Information on accessories and products that can help you get the most from the HP Jornada

Using the manual
This User’s Guide is designed to help you use your HP Jornada quickly and easily. Although great care has been taken to ensure the accuracy of procedures and screen art, some actual screens may be different than the ones that appear in this User’s Guide.

This guide includes the following chapters:

• Chapter 1, Welcome—Contains an overview of the HP Jornada’s built-in applications, where to find more information, and conventions used in this guide.

• Chapter 2, Setting up—Explains the hardware features, how to set up and care for the HP Jornada, and how to manage the battery power.

• Chapter 3, Learning the basics—Describes how to turn the HP Jornada on and off, reconfigure the hard icons, work with the Start menu and taskbar, and adjust settings. Also includes tips and shortcuts to help you work faster.

• Chapter 4, Connecting to a desktop PC—Explains how to install Windows CE Services on your desktop or notebook PC, how to transfer files, how to synchronize data, e-mail messages, and channels, and how to print.

• Chapter 5, Sending and receiving e-mail—Describes how to use Inbox.

• Chapter 6, Staying organized—Explains how to use the HP Jornada to manage your calendar and address book and describes to-do lists, alarms, and reminders.

• Chapter 7, Getting down to business—Describes Microsoft Note Taker ®, bTask from BSQUARE, and
OmniSolve from LandWare. Also explains how to back up and restore data, and how to customize the HP Jornada.

- Chapter 8, Troubleshooting—Contains tips and procedures to follow when things do not work quite as you expected, and explains how to reset the HP Jornada.
- Chapter 9, Warranty, support, and service—Explains the warranty and how to get service.
- Appendix A, Jot Character Recognizer—Describes how to use the Jot character recognizer, and shows how and where to draw characters on the screen for each of the two character sets: the Natural Character Set and the Simplified Uppercase Character Set.
- Appendix B, Migrating data from non-Windows CE HP handheld PC devices—Describes how to use the HP PIM Translation Utility to transfer PIM data from a non-Windows CE HP organizer or Palmtop PC to the HP Jornada.

Using HP Jornada’s built-in programs

This section lists the HP Jornada’s built-in programs. These programs are installed in ROM and cannot be erased or removed.

- Calendar—Keeps track of important dates and events, and helps manage your schedule.
- Tasks—Keeps track of to-do lists. Allows you to set an alarm or a reminder.
- Contacts—Stores names, addresses, and telephone numbers. When you update your contacts list, you can synchronize it with your desktop PC, so that contacts are always up to date.
- Inbox—Sends and receives e-mail messages. Also synchronizes with Microsoft Outlook or Microsoft Exchange on your desktop PC.
- EZOS EzExplorer—Finds files and documents on the P/PC.
- bTask from BSQUARE—Allows you to switch between applications or view the ones currently running. It also allows you to close applications with a single step.
- Note Taker—Allows you to jot quick notes or to create sketches while in a meeting.
- Voice Recorder—Records reminders or vital information when there is no time to type. The dedicated Record button allows you to record messages with one hand.
- Channels—Downloads Web information to the HP Jornada so that it can be viewed offline.
- Connections—Sets up connections for communications with other computers or the Internet.
- ActiveSync™—Synchronizes the HP Jornada with your desktop or notebook PC over a network or dial-up connection from a remote location.
- PC Link—Establishes the connection between the HP Jornada and desktop PC partner.
- Calculator—Performs simple calculations in an on-screen calculator. Allows you to copy the results to any open document.
- OmniSolve from LandWare—Performs complex mathematical and business calculations.
- HP settings—Adjusts and stores up to three settings for the display, sets a password, and displays memory usage.
- HP backup—Backs up Contacts, Calendar, and Tasks data or your entire P/PC to a CompactFlash Memory Card.
- Find—Searches for appointments, channel items, contacts, mail messages, Note Taker notes, tasks, or voice recordings.
- Help—Gives you access to online help.
- Solitaire—Passes the time at the airport, on the train, or during a not-so-interesting meeting or lecture.
- Settings—Adjusts settings for buttons, communications, the stylus, and more.
Finding more information

The following table is a guide to the different types of information available to help you use the HP Jornada. Although this book introduces the programs on your P/PC, it does not describe them completely. For more information, see the comprehensive online Help for each program.

<table>
<thead>
<tr>
<th>Information</th>
<th>Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>Programs</td>
<td>This User's Guide.</td>
</tr>
<tr>
<td></td>
<td>–or–</td>
</tr>
<tr>
<td></td>
<td>Online Help on your P/PC. Tap <strong>Start</strong> and then <strong>Help</strong>.</td>
</tr>
<tr>
<td>Synchronizing and exchanging files with a desktop PC (including information on connecting while traveling)</td>
<td>This User's Guide.</td>
</tr>
<tr>
<td></td>
<td>–or–</td>
</tr>
<tr>
<td></td>
<td>Online Help on your P/PC. Tap <strong>Start</strong> and then <strong>Help</strong>.</td>
</tr>
<tr>
<td></td>
<td>–or–</td>
</tr>
<tr>
<td></td>
<td>Windows CE Services online Help on your desktop computer. In the Mobile Devices window, click <strong>Help</strong>, and then click <strong>Windows CE Services Help Topics</strong>.</td>
</tr>
<tr>
<td>Toolbar buttons and dialog box items</td>
<td>Tap and hold on a toolbar button or dialog box item to see its name or a short description. Drag off the toolbar button or item before lifting to avoid activating it.</td>
</tr>
<tr>
<td>Troubleshooting information on connections</td>
<td>Windows CE Services online Help on your desktop computer. In the Mobile Devices window, click <strong>Help</strong>, then <strong>Windows CE Services Help Topics</strong>.</td>
</tr>
</tbody>
</table>
Information on this release of Windows CE

The Release Notes on your desktop computer. Click **Start**, point to **Programs, Microsoft Windows CE Services**, and then click **Release Notes**.


**Registering the HP Jornada**

To register the HP Jornada, go to www.hp.com/jornada.

**Understanding conventions**

This User's Guide includes visual cues to help you find tips and warnings.

- **A shortcut, another way to do something, or expanded information about the topic.**

- **Caution or warning information about the topic. This is important information that should be observed to prevent loss of data or damage to the HP Jornada.**
This chapter includes instructions to help you:

- identify hardware features
- set up the HP Jornada for the first time
- manage battery power
- care for the HP Jornada
Identifying the hardware features

The views below introduce you to the connectors, ports, and other features of the HP Jornada.

1. AC Charging LED—When connected to AC power, this LED glows with one of two colors:
   - Amber—Indicates that the battery is charging (connected to AC power).
   - Green—Indicates that the battery is fully charged.

2. Notification LED—Blinks red when you have an appointment. Glows red when you are recording.

3. Infrared port (IrDA-compliant transceiver)—Enables you to send and receive files by infrared beam between P/PCs, between the P/PC and a Handheld PC (H/PC), or between the P/PC and a desktop PC. (For more information, see “Connecting by infrared” on page 47.)

4. Microphone—Allows you to record voice memos.
5. Record button—Starts the Voice Recorder. When held, turns on the P/PC when it is off, and records until the button is released.

6. Action button—Pressing this button selects the highlighted item. Rocking this button allows you to scroll (also referred to as Up/Down control).

7. Exit button—Exits dialog windows and menus.

8. Start button—Displays the Start menu. Also turns on the P/PC when it is off, and, if held, brings up HP settings.


10. Battery door release—When pressed with the stylus, releases the battery door.

11. Battery door—Slides down when the battery door release is pressed. Open only when replacing the battery.

12. Hard icon panel—Allows one-touch access to four applications. By default, the applications are Contacts, Calendar, Tasks, and OmniSolve, but these can be reconfigured. To do this, tap Settings from the Start menu, tap Buttons, tap the Program tab, and then follow the directions on the control panel.

13. Power on/off button—Press to power on and off.

14. Display cover—Open the display cover when you want to tap the screen.
15. CompactFlash Type I and II Card slot—Enables you to add memory or use accessories on CompactFlash Cards. (For a list of recommended accessory cards, go to the Hewlett-Packard Web site at www.hp.com/jornada.)

16. Stylus—Use the stylus as a mouse substitute. For example, tap to select a button or menu item, double-tap to open an application, drag the stylus across words or items to select them.

17. Reset button—Restarts the HP Jornada. For more information about soft and full resets, see “Resetting” on page 99.

18. Audio speaker—Lets you listen to system sounds or voice memos.

19. P/PC connector—Connects the P/PC to the cradle.
Setting up for the first time
As part of the setup process, you:
- install the battery
- connect the AC adapter
- start the HP Jornada
- complete the Windows CE Welcome Wizard

Follow the steps described below in the order they are presented.

Installing the battery
The battery powers the HP Jornada when it is not connected to AC power. The battery fits into a compartment on the bottom of the HP Jornada, as shown in the diagram. The switch on the battery does not have any electrical function.

When the battery is drained, you can flip the switch so that the red dot shows to indicate this battery needs to be recharged. This can be convenient if you have more batteries.
This view of the left side of the HP Jornada shows how to insert the battery.

To install the battery

1. Release the battery door by pushing the stylus into the small hole above the door. Then, slide the door down and off.
2. Slide the battery into the battery slot. If the battery does not slide in easily, check the battery orientation and try again. If you are putting the battery in correctly, you do not need to force it.
3. Replace the battery door, and slide it up until it snaps shut.

After you install the battery, the HP Jornada turns on automatically. Before using your P/PC on battery power, though, you should charge the battery by connecting the AC adapter. You can use the P/PC while charging. Charging the battery takes approximately 3 to 4 hours. For information on connecting the AC adapter, read the next sections.
The rechargeable backup battery is a permanent part of the HP Jornada, so you do not need to install or replace it.

The backup battery is charged automatically when the P/PC is connected to AC power.

Make sure you connect to AC power to charge as soon as you see a backup battery low warning.

Do NOT replace your main battery when the backup battery is low.

Using the cradle
The views below show the features of the cradle and how the P/PC docks with it.

1. Release buttons—To release the HP Jornada from the cradle, press the buttons on both sides of the cradle.
2. Connector to the P/PC—Connects the cradle to the P/PC.
14 Hewlett-Packard Jornada 420 Palm-size PC

Back view of the cradle.

1. DC jack—Connects the P/PC to AC power, which also charges both the main and backup batteries.

2. Serial port (RS-232C)—Connects the HP Jornada to your desktop PC to transfer files or to synchronize data. (For more information, see “Connecting for the first time” on page 39.)

The HP Jornada must be in its cradle in order to connect to an AC adapter or to a PC.

Connecting the AC adapter

You can operate the HP Jornada on AC power using the AC adapter and cradle. The AC adapter accepts voltages from 100 V to 240 V, so you can use it anywhere in the world. However, you may need a plug adapter to accommodate different electrical outlets.

When the HP Jornada is connected to AC power, the main battery and backup battery are charged automatically. The AC Charging LED indicates the charging status of the main battery:

- **Amber**—Indicates that the battery is charging (connected to AC power).
- **Green**—Indicates that the battery is fully charged.

The AC Charging LED is illuminated only if the P/PC is connected to AC power.

A dialog box pops up when the backup battery power is low. Connect to AC power immediately to recharge the backup battery.
The AC adapter includes three parts: the power cable, the adapter, and the DC cable.

**To connect to AC power**
1. Plug the DC cable into the back of the cradle.
2. Connect the DC cable to the AC adapter.
3. Connect the power cable to the AC adapter.
4. Plug the power cable into an AC power outlet.
5. Put the HP Jornada into its cradle.

Use the AC adapter to plug the HP Jornada into external power whenever possible, especially when connecting to a desktop PC or other peripheral, or when letting the LED indicator flash for extended time periods. For more information, see “Managing battery power” later in this chapter.

**Running the Welcome Wizard**
After you install the battery, the HP Jornada turns on automatically. At startup, the Hewlett-Packard welcome screen appears. Then, after a few moments, the Windows CE Welcome Wizard begins. The Welcome Wizard leads you through calibrating the stylus, setting your home city, and then setting the World Clock.

The display cover must be open when you tap the screen.
Managing battery power

Because the data and files you save on the HP Jornada are stored in RAM, it is extremely important that you maintain a continuous power supply to the HP Jornada at all times. If the HP Jornada runs out of power, all information you have entered is lost. Although the Windows CE operating system and programs are stored in ROM and cannot be erased, any custom settings and programs you have added are lost.

When taking out the battery, keep in mind that when the P/PC is without power, data retention is guaranteed for only 1 minute. You do not need to take out the main battery except to replace it with a spare battery (F1287A).

The HP Jornada uses a rechargeable lithium-ion battery, which supplies power whenever the P/PC is not connected to AC power. Under normal operating conditions, the battery should last for up to 6 hours of continuous use without recharging. Battery life varies, however, depending on how you use the P/PC.

You should respond immediately when a message warning of low battery power is displayed. When the battery power is low, simply connect the HP Jornada to AC power to recharge.

Using the Power control panel

The Power control panel displays information about the current state of your battery and allows you to control options that can conserve battery power.

To open the Power control panel

1. Tap the Start button, tap Settings, and then tap Power. If you are not familiar with using the Start menu, read “Using the Start Menu and taskbar” on page 24.

   –or–

   If the power plug icon is on the taskbar, double-tap it.

2. Tap the Status, Power, or Dimming tab.
3. Select your preferences. For more information, read the following paragraphs, or tap the Help button.

4. Tap OK to save the changes and exit, or tap the Close button (X in the upper right corner) to abandon the changes.

**Status tab**

The **Status** tab displays the status of the main and backup batteries.

---

**Power Properties**

<table>
<thead>
<tr>
<th>Status</th>
<th>Power</th>
<th>Dimming</th>
</tr>
</thead>
</table>

**Power**

AC Line

- ![Battery Status](image)

**Internal backup battery**

- Low

Connect to AC power immediately to charge your backup battery. Do not remove your main battery when backup battery is low.
Power tab

The **Power** tab lets you customize how and when your P/PC suspends operation to help maximize battery life:

- **Touch screen to power On**—Select this option to allow your P/PC to awake from suspend mode when you tap the screen or hard icon panel.

- **Suspend while on battery power**—To conserve battery power, your P/PC automatically suspends operation after a period of continuous idle time while running on battery power. Select the amount of idle time from the dropdown list.

- **Enable suspend while on AC line power**—Select this option to automatically suspend operation after a period of continuous idle time while running on AC power. Select the amount of idle time from the dropdown list.

The **Touch screen to power On** option is checked by default. When you uncheck this option, you are no longer able to use the hard icon panel to power on the P/PC.
Dimming tab

The **Dimming** tab lets you control backlight dimming to help conserve battery power:

- **Automatically dim while on Battery Power**—To conserve battery power, select this option to automatically dim the backlight after a period of continuous idle time while running on battery power. Select the amount of idle time from the dropdown list.

- **Automatically dim while on AC Power**—Select this option to automatically dim the backlight after a period of continuous idle time while running on AC power. Select the amount of idle time from the dropdown list.

![Power Properties dialog box](image)

Dimming tab

Conserving battery power

The following tips can conserve battery power, ensuring the longest use of your P/PC between charges:

- **Shorten auto-suspend time.** To set auto-suspend time: from the **Start** menu, tap **Settings**, tap **Power**, and then tap the **Power** tab.
Set the display to dim automatically after a short time. To set dimming: from the Start menu, tap Settings, tap Power, and then tap the Dimming tab.

Minimize brightness and use contrast to increase readability. To set brightness and contrast: from the Start menu, tap HP settings. For more information about HP settings, see “Using HP settings” on page 31.

Turn off sounds you do not need or mute the system speaker. To mute sounds: from the Start menu, tap HP settings. For more information about HP settings, see “Using HP settings” on page 31.

Connect to AC power when connected to any peripherals requiring power.

Connect to AC power when connected to your desktop PC.

**Caring for the HP Jornada**

Follow these suggestions for long and trouble-free use.

- To clean the screen, wipe it with a damp, lint-free cloth.
- Do not drop the HP Jornada. Accidental damage is not covered under the Hewlett-Packard express warranty.
- Radiated interference from other electronic equipment may affect the appearance of the display. To return the display to normal, remove the P/PC from the source of the interference.
- The HP Jornada is designed to operate at temperatures between 0 to 40 °C (32 to 104 °F). It is designed to maintain data at temperatures between 0 to 55 °C (32 to 131 °F).

Subjecting the P/PC to temperatures outside those ranges may damage the P/PC or result in loss of data. Be especially careful not to leave the HP Jornada in direct sunlight or in a car where temperatures can rise to harmful levels.
3 | Learning the basics

This chapter describes the following:

- turning the HP Jornada on and off
- using and reconfiguring the hard icons
- working with the Start menu, taskbar, command bar, and online help
- adjusting settings, such as volume and the world clock
- using shortcuts to help you work faster

Turning the HP Jornada 420 on and off

The HP Jornada does not need to be started up or shut down; you can start working immediately by pressing the On/Off button at the lower right corner of the P/PC. When you are finished, turn off the HP Jornada by pressing the On/Off button. Turning off the HP Jornada simply suspends operation. When you turn it on again, you can start working where you left off.

You can also turn on the HP Jornada in the following ways:

- by pressing the **Start** button
- by pressing the **Record** button
- by holding the stylus down on one of the hard icons
- by tapping the screen.

To conserve battery power, you can set the HP Jornada to auto-suspend after a preset period of continuous idle time. By default, the P/PC auto-suspends after 3 minutes while running on battery power. (For more information on auto-suspend and tips for conserving battery power, see “Managing battery power” on page 16.)
**Locking the hardware buttons**
Pressing the Record button or the Start button powers on the P/PC. To avoid powering on the P/PC accidentally (which would drain the battery), you can lock the hardware buttons that are on the left side of the P/PC.

To lock the buttons
1. Press and hold the On/Off button to lock the buttons. When the volume is not muted, a sound indicates that Button Lock is enabled, and the lock icon appears in the taskbar.

To unlock the buttons
1. When the buttons are locked, press and hold the On/Off button to unlock the buttons. When the volume is not muted, a sound indicates that Button Lock is disabled, and the lock icon disappears from the taskbar.

When Button Lock is enabled, all hardware buttons are disabled, except for the On/Off button.

**Using the hard icons**
To launch Contacts, Calendar, Tasks, or OmniSolve, tap the appropriate icon at the bottom of the display. If you double-tap the icon, the Edit windows for Contacts, Calendar, and Tasks are displayed.

To reconfigure the hard icons
1. Tap Settings from the Start menu.
2. Tap Buttons.
3. Tap the Program tab.
4. Tap the name of the hard icon (under Program button) that you want to reconfigure.
5. Tap the name of the program (under **Button** assignment) that you want to associate with the hard icon.

6. Tap **OK**.

**Using the Active Desktop**

You can use the Active Desktop™ to display important information, such as today's appointments and tasks. You can also display channel information, such as stock quotes. For more information, see “Displaying mobile desktop components” on page 54.

To select the type of information you want to display on the desktop, tap **Start**, **Settings**, **Display**, and then **Display Active Desktop**.
Using the Start Menu and taskbar

Use the Start menu on the taskbar to switch programs, display settings, find information, and view Help for the current program.
On the taskbar, you can also do the following.

![Taskbar Options]

*Choose from a list of input methods.*

*Open the input panel.*

*Display or hide the input panel.*

*Double-tap an icon for more information.*

You can change what you see on the **Start** menu and taskbar by tapping **Start**, **Settings**, and then **Taskbar**.

### Using the command bar

The command bar at the top of the P/PC screen includes both menu names and toolbar buttons. You can decide which you want to display.

*Drag horizontally to see the menu names you want.*

*Tap to quickly show all menu names.*

*Tap to show buttons only. Drag down to show menu names and toolbar buttons.*

### Typing, writing, and drawing on the HP Jornada

With your P/PC, you can quickly type, write, and draw in the way that is most convenient for you. You can type with the soft keyboard, write using character recognition, or write and draw directly on the screen using your stylus.

In **Note Taker**, and in notes that you attach to entries in **Calendar**, **Contacts**, and **Tasks**, you can use your stylus to write...
on the screen. For more information, see “Creating notes and drawings” on page 77.

You can enter information in any program on your P/PC by typing with the soft keyboard or writing using character recognition. First select the input method you want to use in your P/PC’s input panel. Tap the Input Method arrow to see your choices.

**Typing with the keyboard**

To type, tap the Input Method arrow and select **Keyboard**. Then tap the keys with your stylus.

Characters are displayed as you tap them.

You can adjust keyboard settings to suit the way you work. Tap **Start**, **Settings**, and then **Input Panel**. Select **Keyboard** as the input method, and then tap **Options**.

Enable swipe shortcuts (gestures) on your keyboard so that you can do the following:

- To insert a space, swipe across the keyboard from left to right.
- To delete a character, swipe across the keyboard from right to left.
- To enter a carriage return, swipe the keyboard from top to bottom.
To enter the character in uppercase, starting on a key, swipe up.

**Using character recognition**

You can use the character recognition software, CIC® Jot™, to write. Tap the **Input Method** arrow and select **Jot Character Recognizer**. When you write a letter in the box, your handwritten character is converted to typed text that appears on the screen.

Some letters must be written in a particular way to be recognized. To see how to write letters, tap the **Help** button for an online demonstration or see Appendix A.
Drag your stylus across the panel horizontally from right to left to delete a character. Drag from left to right to type a space.

As you type or write, your P/PC anticipates the word you are writing and displays it above the input panel. When you tap the displayed word, it is inserted into your text at the insertion point. The more you use your P/PC, the more words it learns to anticipate.

To customize the suggested words, tap **Start**, **Settings**, **Input Panel**, and then the **Word Completion** tab.

**Finding files and documents**

EzExplorer is your gateway to all the applications, documents, and other files on your P/PC. It displays information using familiar folder and file names. In EzExplorer, you can browse, copy, move, delete, and rename the files and folders in your system, and you can create shortcuts to frequently used items.

To start EzExplorer

1. From the **Start** menu, tap **Programs**, and then tap **EzExplorer**.
For detailed procedures about using EzExplorer, refer to online Help.

**Finding information**

The Find feature on your P/PC helps you quickly locate information. Tap **Start** and then **Find**. Enter the text you want to find, select a data type, and then tap **OK** to start the search.

![Finding information screenshot]

**Viewing information**

Most programs provide a list view, showing the items or files you have already created in that program. You can display the list in the manner that is most helpful for you.

You can sort the list on a particular column by tapping the column heading.

In Calendar, Contacts, and Tasks, you can assign entries to particular categories and then filter the list to show a specific category.

In Note Taker, Voice Recorder, and Inbox, you can place files or messages in folders, and then filter the list to show only the files or messages in a specific folder.
Adjusting settings

You can adjust P/PC settings to suit the way you work. Select Start and then Settings to see the settings available on your P/PC.

You might want to adjust the following:

- **Buttons**, to associate program buttons with specific programs and to adjust the Up/Down control.
- **Owner**, to enter contact information in case your P/PC is misplaced.
- **Power**, to maximize battery life.
- **System**, to adjust memory allocation between storage memory and program memory.
- **Password**, to limit access to your P/PC.
- **Volume & Sounds**, to customize or turn off sounds.
- **World Clock**, to set the date and time for your location and a second location.

For information on a particular setting, you can do either of the following:

- Open the setting, tap Start, and then tap Help.
- Open the setting, and then tap and hold on the label of the item you want more information about, as shown in the figure on the next page.
Using HP settings

Use HP settings to adjust screen brightness and contrast, speaker volume, your password, and password protection. You can also display system information such as memory status and remaining battery power.

Setting brightness, contrast, and volume

You can adjust the screen brightness and contrast, adjust the speaker volume to suit your work environment, and check the remaining battery power and memory status. You can also mute the speaker by selecting the speaker mute checkbox.

To set brightness, contrast, and volume

1. Tap the Start button, and then tap HP settings.
   - or -
   Hold the Start button for 1 second.
2. Adjust the contrast, brightness, and volume sliders on the Settings tab, and then select or deselect the Mute check box to mute or restore the system volume.
**HP settings** allows you to adjust brightness, contrast, and volume by using the **Action** button. Hold the **Start** button to open **HP settings**, and use the **Action** button to cycle the profiles and to select the preferred one.

![HP settings](image)

**Settings tab**

The HP Jornada has four preset HP settings profiles. You can launch any profile by selecting the radio button associated with it. You can also adjust any of the settings in any profile to suit your preference.
To change profiles
1. Select the radio button of the profile you want to change.
2. Adjust sound, brightness, and contrast sliders to your preference.
3. Tap OK to save the new settings. Tapping the Close button exits this window and abandons all changes.

You can switch to the Volume & Sounds control panel by tapping the Speaker button.

Viewing battery status
The Settings tab displays the remaining battery capacity on a status bar at the bottom of the window. You can also view power status on the Power control panel.

To switch to the Power control panel
1. Tap the Battery button next to the battery status bar.
Viewing memory status

The **Memory** tab displays total and available (free) Storage and Program memory.

<table>
<thead>
<tr>
<th>HP settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Settings</td>
</tr>
</tbody>
</table>

**Storage Memory:**
- Free: 3860 KB
- Total: 4013 KB

**Program Memory:**
- Free: 2296 KB
- Total: 4014 KB

**Storage Card:**
- Free: No card
- Total: No card

Memory tab

To adjust how memory is allocated between storage and programs:

1. Switch to the **System** control panel by tapping the **Windows** button next to the memory status display.
2. Tap the **Memory** tab.
3. Move the slider to the left or right.
4. Press the **Action** button or tap the **OK** button to exit and save all changes.

   - or -

   Press the **Exit** button or tap the **Close** button to exit this window and abandon all changes.

### Setting a password and delay timer

You can protect the HP Jornada by setting a password. You can also choose to be prompted to enter the password each time you turn on the P/PC.

![Password tab](image)

**Password tab**

To set your password and an optional password delay timer

1. Tap the **Start** button, and then tap **HP settings**.

   - or -

   Hold the **Start** button for 1 second.

2. Tap the **Password** tab.
3. Tap **Set Password**.

4. Enter a password by tapping characters on the keyboard, and then enter the same password in the **Confirm** password text box.

5. If you want, tap the **Enable password protection at power-on** checkbox.

6. Press the **Action** button or tap the **OK** button to exit and save all changes.

   - or -

   Press the **Exit** button or tap the **Close** button to exit this window and abandon all changes.

7. If you enabled password protection at power-on, the **Activate password protection** radio buttons become active. The default is to activate immediately after suspend.

8. If you want, choose the **After suspending for** radio button, and then select one of the preset delay times from the list. The delay allows you to turn your P/PC back on within the allotted time without having to enter your password.

9. Press the **Action** button or tap the **OK** button to exit and save all changes.

   - or -

   Press the **Exit** button or tap the **Close** button to exit this window and abandon all changes.

---

**Learning the shortcuts**

The following tips and shortcuts help you work faster.

- Turn on the HP Jornada by pressing the **On/Off** button, by pressing the **Start** button, by pressing the **Record** button, by holding the stylus down on one of the hard icons, or by tapping the screen.

- Press the **Start** button to bring up the **Start** menu.

- Hold down the **Start** button to bring up **HP settings**.
• Hold down the **Record** button to start recording. Recording stops when you release the button.
   To play all of your recordings one after another, press the **Action** button twice. A short beep sounds between recordings.

• Press the **Action** button to execute a highlighted item. Rock this button to scroll up and down through dropdown lists.

• Press the **Exit** button to exit dialog windows.

• Reconfigure the hard icons so that they start the applications that you use most often. To do this, tap **Settings** from the **Start** menu, tap **Buttons**, tap the **Program** tab, and then follow the directions on the control panel.

• Use the AC adapter to plug the HP Jornada into external power whenever possible, especially when connecting to a desktop PC or other peripheral, or when letting the LED indicator flash for extended time periods. For more information, see “Managing battery power” on page 16.

• In Calendar, to choose the way you prefer to be notified, on the **Tools** menu, tap **Options**, tap the **Alarm** button, and then tap **Reminder Options**.

• If you have lost the HP Jornada or replaced it with another HP Jornada, you can set up the new P/PC with the same data and settings as the old one, if you previously performed a full backup using Windows CE Services or HP backup.

  If you used Windows CE Services to back up your data, then when you connect the new P/PC to your desktop PC for the first time, choose Restore rather than Synchronize or Browse. If you backed up the P/PC using HP backup, then restore the information as described in “Using HP backup” on page 84.

• Speed up the synchronization process by synchronizing regularly. If you use Microsoft Outlook, Windows CE Services synchronizes only 2 weeks of calendar data by default.

• To open the **World Clock** control panel quickly, double-tap the clock in the status area of the taskbar.

• To close applications use bTask, or from the **Start** menu, tap **Settings**, tap **System**, tap **Task Manager**, select the application you want to close, and then tap **End Task**.
Hewlett-Packard Jornada 420 Palm-size PC
Chapter 4 | Connecting to a desktop PC | 39

4 | Connecting to a desktop PC

This chapter describes how to:

- install Windows CE Services
- establish a partnership between the HP Jornada and your desktop PC
- use Windows CE Services to browse the contents of the HP Jornada
- synchronize data, e-mail messages, and channels
- transfer files between the HP Jornada and desktop PC

Connecting for the first time

You can connect to a desktop PC using the HP Jornada serial port, or you can connect to an infrared-equipped desktop or notebook PC using the infrared port. Before you connect, you must install Windows CE Services on the desktop PC. Then, you can connect the HP Jornada to your desktop PC with the sync cable or the infrared port, and establish a partnership.

Understanding Windows CE Services

Microsoft Windows CE Services with ActiveSync enables you to synchronize the information on your desktop computer with the information on your P/PC. Synchronization is the process of comparing the data on your P/PC with your desktop computer and updating both computers with the most recent information. For example:

- Keep Contacts, Calendar, and Tasks data up-to-date by synchronizing your mobile device with your choice of Microsoft Outlook (Inbox synchronization with Outlook Express is not
currently supported), Microsoft Schedule+, or Microsoft Exchange on your desktop computer.

- Synchronize Voice Recorder and Note Taker documents between your P/PC and desktop computer. Your files are automatically converted to the correct format.

With Windows CE Services, you can also:

- back up and restore your P/PC data
- add and remove programs on your P/PC
- copy (rather than synchronize) files between your P/PC and your desktop computer

Windows CE Services includes several components. The Windows CE Services Setup Wizard detects which software components are needed and prompts you to set up only the necessary components. For instance,

- If you do not already have Outlook or Schedule+ installed, the Setup Wizard attempts to install Schedule+ version 7.0a.
- The Setup Wizard can add Inbox extensions to enable you to transfer messages to your desktop mail client—Exchange or Outlook.

You may need to restart your PC after installing each component.

Contents of the Desktop Software for Microsoft Windows CE compact disk

The Desktop Software for Microsoft Windows CE compact disk includes the following software options for your desktop PC.

- Windows CE Services—Allows you to connect the HP Jornada to a desktop or notebook PC running Windows 95 or Windows NT.
- Microsoft Exchange Update—Adds an option to the Tools menu in Microsoft Exchange, allowing you to synchronize the HP Jornada Inbox with your Windows Inbox.
- Microsoft Schedule+ 7.0a—A schedule management program for Windows 95 or NT.
- Ethernet Components—Network drivers for your Windows CE.
Chapter 4 | Connecting to a desktop PC | 41

- Microsoft Pocket Streets—A maps-and-navigation program for Windows CE.
- Windows 95 infrared drivers version 2.0—Allow you to install an infrared port on a desktop PC.
- Windows 95 Dial-Up Networking version 1.2 upgrade—Allows you to establish a remote connection to your desktop PC by modem.
- Microsoft Internet Explorer version 4.01—The most recent version of the Internet browser for Windows 95 or Windows NT.
- Windows NT Service Pack 3—System updates for Windows NT.

Many Windows CE programs are available, including freeware and shareware. Go to www.microsoft.com/windowsce, or try searching the Web on the keyword “Windows CE” to find additional programs for your P/PC.

Minimum PC requirements for Windows CE Services
The minimum PC requirements for running Windows CE Services are as follows:

- Microsoft Windows NT Workstation 4.0 or Windows 95 (or later)
- Desktop PC with a 486/33DX or higher processor (Pentium® P90 recommended)
- 8 MB of memory (12 MB recommended) for Windows 95 (or later), and 16 MB of memory (32MB recommended) for Windows NT Workstation
- Hard disk drive with 10 to 50 MB of available hard disk space (actual requirements vary, based on selection of features and current system configuration)
- Available 9-pin serial communications port
- CD-ROM drive
- VGA or higher resolution graphics card (SVGA 256-color recommended)
To install Windows CE Services

1. If you want to upgrade to Microsoft Outlook 98, install it first.

2. Insert the Desktop Software for Microsoft Windows CE compact disk into the CD-ROM drive on your desktop PC.

3. The Windows CE Services Setup Wizard should start automatically. If it does not start, click Run on the Start menu, and then type d:\setup, where d is the letter assigned to your CD-ROM drive.

4. Follow the instructions that appear on your screen to set up Windows CE Services.

5. The Windows CE Services Get Connected dialog box appears and prompts you to connect the HP Jornada.
   - If you connect using the sync cable, connect your P/PC as described in “Connecting by sync cable” on page 42, and then click Start.
   - If you connect by infrared, click Cancel, and skip to “Connecting by infrared” on page 47.

If you chose Manual synchronization, you need to tap Start, tap Programs, tap Communication, and then tap PC Link.

Connecting by sync cable

The HP Jornada uses a serial connection to communicate with a desktop PC. The serial connection is established with the sync cable (included with the HP Jornada) and a 9-pin serial communications port on your desktop PC.

The HP Jornada 420 connects to the sync cable via the cradle.

If you do not have a 9-pin serial port on your desktop PC, or if the port is in use by another device, such as a printer or modem, you may need to obtain an adapter from your computer manufacturer.
To connect the HP Jornada to your desktop PC

1. Insert the 9-pin end of the sync cable into a serial port on your desktop PC.
2. Fully insert the flat end of the sync cable, arrow side up, into the serial port on the cradle.
3. Insert AC adapter into the DC jack on the cradle.
4. Mount the HP Jornada in the cradle.

Establishing a partnership

After you set up Windows CE Services on your desktop PC and connect your HP Jornada with the serial cable to the desktop PC, you are prompted to establish a partnership between your desktop PC and the HP Jornada. The partnership enables your desktop PC to recognize the HP Jornada when transferring files or synchronizing data.

You can establish partnerships between the HP Jornada and up to two desktop PCs (for example, your home PC and your office PC). A single desktop PC can partner with any number of H/PCs or P/PCs. This is useful if you have more than one computer running Windows CE, or if several people share a single desktop PC.
Following the New Partnership Wizard

The New Partnership Wizard helps you create a partnership and gives you options for synchronizing data, e-mail messages, and files between the HP Jornada and desktop PC. When the New Mobile Device Detected dialog box appears on your desktop PC, click Synchronize, and then follow the instructions on the screen of your desktop PC to complete the New Partnership Wizard.

The Wizard prompts you to type a name and a description for the P/PC. The name can be anything you choose (up to 15 alphanumeric characters, no spaces) and should make it easy for you to identify the HP Jornada. The description could be the make and model (for example, HP Jornada 420) or a property control number.

You can later change the device name and description using the Communication control panel on the HP Jornada. On the Start menu, tap Programs, tap Communication, and then tap Connections.

The Wizard also prompts you to choose settings for synchronization: Manual, On Connect, or Continuous. If you choose Continuous, information is synchronized whenever it changes for as long as the computers are connected.

The P/PC icon appears in the Mobile Devices window after the new partnership is created, which can take a minute or two.

To change the type of items that are synchronized after you have completed the wizard, select the P/PC icon in the Mobile Devices folder and then click ActiveSync Options on the Tools menu.

Also, regardless of the options you choose while completing the Wizard, you can also synchronize at any moment by choosing the Synchronize Now command from the Tools menu of the Mobile Devices window. Or, right-click the connection icon in the taskbar of the desktop PC, and then click Synchronize Now. For more information, see “Synchronizing data” on page 50.
Troubleshooting partnerships

If you are unable to establish a connection between the HP Jornada and your desktop PC, try the following:

- Confirm that both the desktop PC and the HP Jornada are communicating at the same baud rate.

To check the baud rate on your desktop PC

1. Click **Communications** on the **File** menu of the Mobile Devices window.

To check and change the baud rate on the HP Jornada

1. On the **Start** menu, tap **Settings**, tap **Communications**, and then tap the **PC Connection** tab.

    Communications Properties, PC Connection tab

2. To change the baud rate setting, tap **Change Connection**.

- Verify that the sync cable from the HP Jornada is connected to the port listed on the **Communications** tab of the Windows
CE Services Properties dialog box (this is the port you selected when setting up Windows CE Services).

If these steps fail to correct the problem, use the Windows CE Services Communications Troubleshooter. The Communications Troubleshooter provides detailed diagnostic steps to identify and correct common problems.

**To start the Communications Troubleshooter**

1. On the **Start** menu of your desktop PC, point to Microsoft Windows CE Services, and click Mobile Devices.
2. On the **Help** menu in the Mobile Devices window, click Communications Troubleshooter.

**Connecting and disconnecting**

After you have established a partnership, you can set Windows CE Services to automatically detect the HP Jornada and establish a connection whenever you connect the sync cable. Using the COM port on your desktop PC is the easiest way for you to connect, unless you use that port for other peripherals.

**To enable automatic connection**

1. On the **Start** menu of your desktop PC, point to Microsoft Windows CE Services, and click Mobile Devices.
2. On the **File** menu in the Mobile Devices window, click Communications.
3. Under Device Connections via Serial Port, click **Enable Auto Connect**.

If you use the COM port of your desktop PC for other devices, or if you have disconnected the HP Jornada and need to reestablish the connection, you can establish a manual connection using the PC Link program on the HP Jornada.

**To connect manually**

1. On the HP Jornada **Start** menu, tap **Programs**, tap **Communications**, and then tap **PC Link**. The **Connection Status** dialog box appears. After a few
moments a sound indicates that the connection is being established.

The HP Jornada icon in the Mobile Devices window is grayed out until the connection is established, which can take a minute or two.

To close the connection

1. On the HP Jornada, double-tap the connection icon in the status area of the taskbar.
2. In the **Connection Status** dialog box, tap **Disconnect**.

**Connecting by infrared**

You can use the infrared port on the HP Jornada to connect to a desktop or notebook PC that is running Windows 95 (or later). Once connected, you can transfer files and synchronize data and e-mail messages just as if you had connected using the sync cable.

Line up the IR ports on the two devices so that they are within 20 centimeters (8 inches) of one another.

Before you can connect by infrared, you must set up and configure an infrared port on your desktop or notebook PC. Many notebook PCs have a built-in infrared port; however, you may need to install a third-party infrared transceiver on your desktop PC. For more information about installing and configuring that device for use with your desktop PC, refer to the instructions that came with your infrared port.

The Desktop Software for Microsoft Windows CE compact disk also includes infrared device drivers for Windows 95.

To configure Windows CE Services for infrared connection

1. Insert the Desktop Software for Microsoft Windows CE compact disk into the CD-ROM drive on your desktop PC, and then run Setup.exe.
2. Click **Optional Components**, and then select the Windows 95 Communications Driver setup program.
3. When the setup program prompts you to specify a communications port, select a virtual port (typically COM3).

4. When setup is complete, restart your desktop PC, and then open the Mobile Devices window.

5. In the Mobile Devices window, click Communications on the File menu.

6. Under Port, select the infrared port you installed when you set up the infrared device.

   –or–

   Click New to install the port. (If you install a new port, you may need to reinstall Windows CE Services.)

To configure the HP Jornada for infrared connection

1. On the HP Jornada Start menu, tap Settings, then tap Communications.

2. Tap the PC Connection tab. If the control panel does not show Connect using Infrared Port, tap Change Connection, and then select Infrared Port from the list of available connections.

To establish an infrared connection

1. Line up the infrared port on the HP Jornada with the infrared device on your notebook or desktop PC.

2. On the HP Jornada Start menu, tap Programs, tap Communications, and then tap PC Link.

Connecting to another PC

In some cases, you may need to connect the HP Jornada to a desktop PC other than your partner. Or, there may be times when your desktop PC does not recognize the HP Jornada as its partner. This occurs if you have logged on to the desktop PC with a different user name or if you performed a full reset of the HP Jornada by removing all power or allowing the batteries to die.

In these cases, when you connect the HP Jornada to a PC, the New Mobile Device Detected dialog box appears, offering you the
option to Synchronize, Browse, or to Restore data from an existing backup file.

If you choose Synchronize, the New Partnership Wizard begins, and the HP Jornada is designated as a partner of the desktop PC.

If you choose Browse, the HP Jornada is connected as a “guest.” As a guest, you can view files and folders on the HP Jornada, transfer files and folders, and manually back up or restore. However, you cannot synchronize data or automatically back up and restore data.

If you choose Restore, you are given the option to restore data from an existing backup file on the desktop PC. Restoring data in this way replaces all existing data on the HP Jornada with the data in the backup file on your PC.

If you have lost the HP Jornada or replaced it with another HP Jornada, you can set up the new P/PC with the same data and settings as the old one, if you previously performed a full backup using Windows CE Services or HP backup.

If you used Windows CE Services to back up your data, then when you connect the new P/PC to your desktop PC for the first time, choose Restore rather than Synchronize or Browse. If you backed up the P/PC using HP backup, then restore the information as described in “Using HP backup” on page 84.

**Browsing the HP Jornada desktop**

While the HP Jornada is connected to a desktop PC, you can use Windows CE Services to browse the contents of the HP Jornada from your desktop.

To browse the HP Jornada desktop

1. Double-click the HP Jornada icon in the Mobile Devices window on your desktop PC. The contents are displayed as any other folder on your desktop PC.

You can cut, paste, and copy files between folders on the P/PC, or transfer files between the P/PC and your desktop PC, simply by dragging the file icons between the appropriate folders.
For more information about transferring files, see “Transferring files” on page 54.

You cannot open files or start programs stored on the P/PC by double-clicking their icons in the Mobile Devices window. When you double-click the icon for a file or program that is stored on the P/PC, Windows CE Services displays the properties for that file or program, as if you had clicked Properties on the File menu.

**Synchronizing data**

Windows CE Services with ActiveSync enables you to synchronize data between the HP Jornada and desktop PC, so the names you add to your Contacts database and the appointments you add to your Calendar while traveling can be automatically updated on your desktop PC when you return. You can also synchronize messages in the HP Jornada Inbox with Microsoft Outlook or Microsoft Exchange on your desktop PC, and download channels.

You can set ActiveSync either to synchronize automatically each time you connect the HP Jornada to your desktop PC, or to synchronize continuously whenever the synchronized information changes, for as long as the computers are connected. You can also synchronize at any moment by choosing Synchronize Now from the Tools menu in the Mobile Devices window.

**Synchronizing selected data**

You can choose some or all of the following items to be synchronized:

- Calendar, Contacts, or Tasks information—Exchange and update information on the HP Jornada with information stored in Outlook or Schedule+ on your desktop PC.

- E-mail messages—Share messages between selected folders in the HP Jornada Inbox and Exchange or Outlook on your desktop PC. For information on Inbox, see “Using Inbox” on page 61.
Chapter 4 | Connecting to a desktop PC

- Channels—Download Internet, intranet, or other Web-formatted content to the P/PC. For information on channels, see “Using channels” on page 52.

All files you create on your P/PC, such as Voice Recorder and Note Taker files, are stored in a My Documents folder. You can see these files by double-clicking your P/PC icon in the Mobile Devices window on your desktop computer.

When Note Taker files are copied to the desktop computer, they are converted to .doc files and can be opened in Microsoft Word. When Microsoft Word (.doc) files are copied to the P/PC, they must be converted manually to Note Taker (.pwi) files in order to be opened in Note Taker.

**To convert .doc files to .pwi files**

1. In the Mobile Devices window on your desktop PC, go to the Tools menu, and then select File Conversion.
2. Select the Desktop to Device tab, and select Microsoft Word Document from the list.
3. Click Edit, and in the Convert to mobile device file of the type drop-down list, select the Note Taker (*.pwi) format.
4. Click OK to exit. For more information, see Windows CE Services Help.

Voice Recorder files remain .wav files on both your P/PC and desktop computer. Synchronization gives you a handy way to move your Voice Recorder files to your desktop computer. A special playback codec, provided with the Windows CE Services installation, is needed to play P/PC .wav files recorded in Mobile Voice format on your desktop computer. PCM files can be played on any desktop PC.

**To specify data to synchronize**

1. On your desktop PC, open the Mobile Devices window, and then select the P/PC icon.
2. On the Tools menu, click ActiveSync Options.
3. On the General tab of the ActiveSync Options dialog box, select the check boxes beside the services you want to synchronize.
4. To set specific options (for example, to indicate how many weeks of Calendar data to synchronize, or to synchronize only active tasks), select the appropriate service, and then click Options.

> Speed up the synchronization process by synchronizing regularly. If you use Microsoft Outlook, Windows CE Services synchronizes only 2 weeks of calendar data by default.

Resolving synchronization conflicts

If the same item (for example, an appointment or a task) has been modified on both the desktop PC and on the HP Jornada, ActiveSync indicates that a synchronization conflict has occurred. When the Resolve Conflicts dialog box appears, you can either resolve the conflict by selecting one of the items to replace or you can ignore the conflict.

You can resolve each conflict manually, at the time of synchronization, or you can resolve conflicts automatically by setting a default option for conflict resolution.

To set a default option for conflict resolution

1. Open the Mobile Devices window, and then select the P/PC icon.
2. On the Tools menu, click ActiveSync Options.
3. On the General tab of the ActiveSync Options dialog box, click Advanced.
4. Select the option you prefer to resolve conflicts.

Using channels

A channel is a Web site or other Web-formatted content that is available for offline viewing on your P/PC. Channels allows Internet, intranet, or other Web-formatted content to be automatically downloaded to your P/PC from your desktop computer via synchronization.

Content can be updated on a regular basis, such as updates from a news channel, or on a one-time basis, such as movie listings from an entertainment channel.
Channels and automatic updates to them are managed on the desktop computer by Internet Explorer 4.0. Use Internet Explorer 4.0 on your desktop computer to subscribe to Mobile Channels.

A special Web site has been set up to help you get started using Channels. For information on getting started with Channels on your P/PC, go to http://www.microsoft.com/windowsce/channels/.

Personalizing channels
Some channels are divided into content areas. You can choose which content areas you want to download to your P/PC. In Channels, tap File, then Channels, and select the channels and content areas you want.

You can specify the amount of channel information that is transferred to your P/PC. Tap View, then Options. Channel information is stored on your P/PC, and new content replaces older content.

To remove a channel and all of its content, tap File, then Channels, and clear the channel that you want to remove.

Synchronizing channel information
Channel information can be synchronized as part of the general synchronization process described above. In the Mobile Devices window of Windows CE Services, click Tools, ActiveSync Options, then select Channel Item.

During synchronization, channel information is copied to your P/PC. It can be viewed either from Channels or on your Active Desktop as a mobile desktop component, depending on the channel format you have subscribed to. See “Mobile desktop components” later in this chapter for more information.

Viewing channel content
Whenever new content is available for one of your channels, you see the Channel icon in the status area of the taskbar. Double-tap the icon to switch to Channels, or tap Start, then Channels.
To view channel content, tap an icon on the Channel bar, or tap the Explore Channel button to quickly navigate to a channel or to a specific page within a channel.

Displaying mobile desktop components
The P/PC also includes an Active Desktop feature that can display specialized channel content for quick reference. Similar to Channels, content for mobile desktop components is synchronized with the desktop computer. For example, a content provider might create a mobile desktop component that updates and displays key financial market indices during the day.

To display mobile desktop components on the Active Desktop, tap Start, Settings, Display, and then select the components you want to display.

Transferring files
You can copy files between the HP Jornada and desktop PC by dragging icons to or from the P/PC icon in the Mobile Devices window on your desktop PC or by using the Cut, Copy, and Paste commands on the Edit menu.

Printing
If you want hard copies of files on your P/PC, you must transfer them to your desktop PC for printing. You cannot print files directly from the P/PC.
5 | Sending and receiving e-mail

With Inbox, you can keep in touch with your office, home, and clients by sending and receiving e-mail messages in any of these ways:

- synchronize messages with Microsoft Exchange or Microsoft Outlook on your desktop computer
- transfer individual messages using Windows CE Inbox Transfer
- send and receive messages using a dial-up connection to an ISP or an Ethernet connection to your Corporate Network

Synchronizing messages

E-mail messages can be synchronized as part of the general synchronization process described in “Synchronizing data” on page 50. During synchronization:

- Messages are copied from the Inbox folder of Exchange or Outlook on your desktop computer to the Inbox folder on your P/PC. The messages on the two computers are linked, so when you delete a message on your P/PC, it is deleted from your desktop computer as well the next time you synchronize.
- Messages in the Outbox folder on your P/PC are transferred to Exchange or Outlook, and then sent from those programs.

Features available on your desktop computer, such as scheduling meetings and selective downloading of file attachments, are also available on your P/PC.

By default, e-mail synchronization is disabled. To enable e-mail synchronization, in the Mobile Devices window on your desktop computer, click Tools, ActiveSync Options, select Message, and then click OK.
After you have enabled message synchronization, you can set message synchronization options by closing the dialog box and then reopening it. Select **Message** and then click **Options**.

### Using Windows CE Inbox Transfer

You can use Windows CE Inbox Transfer to copy or move specific messages between Exchange or Outlook and your P/PC, and you can move them into folders other than the Inbox. The messages on the two computers are not linked. You can modify or delete messages from one location without affecting the other.

You can also use this method to move messages to your desktop computer that you have received on your P/PC from other services, such as paging and faxing services.

To transfer messages, connect the P/PC to the desktop computer. In either Exchange or Outlook, click **Tools**, then **Windows CE Inbox Transfer**, and then indicate what you want to do.
Sending and receiving messages using a dial-up connection

If you want e-mail service, you need:

- a modem
- a PPP (Point-to-Point Protocol) or SLIP (Serial Line Internet Protocol) account to an Internet service provider (ISP)
- a dial-up connection set up on the HP Jornada
- access to a phone line
Connecting to the Internet

Installing and configuring a modem

The HP Jornada 420 supports CompactFlash Card modems. Follow the manufacturer’s instructions included with the CompactFlash Card modem to install and configure it for use with the HP Jornada.

Getting an account with an Internet service provider

To send and receive e-mail, you need to contact an ISP to set up a PPP account. SLIP accounts are offered by some ISPs instead of PPP accounts. The HP Jornada supports the use of SLIP as well as PPP.

Your ISP gives you the configuration information you need to connect the HP Jornada to e-mail service:

- your account user name
- your account password
- phone number of your ISP’s modem
- IP and DNS addresses, if necessary
- your e-mail user name or ID (this may be the same as the user name for your ISP account)
- your e-mail password (this may be the same as the password for your ISP account)
Setting up a dial-up connection to your ISP

After you have established an account with an ISP, you can set up a connection on the HP Jornada and send and receive e-mail whenever you want.

To set up a dial-up connection

1. On the Start menu, tap Programs, tap Communication, and then tap Connections.
2. In the Connections folder, double-tap Make New Connection, and type a name for the connection.
3. In the Make New Connection dialog box, select Dial-Up Connection, and then tap Next.
4. Select the down-arrow button next to the Select a modem box, and highlight the name of your modem. If you do not see your modem listed in the drop-down list, your modem may not be properly connected to your P/PC. Make sure that the modem is connected to your P/PC properly, based on the installation instructions that came with the modem.
5. Tap Next and fill in the phone number you wish to dial. Tap Finish. A new icon appears with the name you specified in the Connections folder. This connection also appears on the Start menu in the Connections submenu.

Connecting to your ISP

After you have configured your connection to your ISP, you are ready to connect your phone line to your modem, and then dial in. Make sure you connect to the phone line supported by your modem, follow the instructions provided by the manufacturer. Most CompactFlash Card modems use analog phone lines.
To connect to your ISP

1. Plug your modem's phone cord into a standard phone jack.

2. To use your new connection, double-tap the new icon in the Connection folder (or select the new icon from the Start/Programs/Communication menu).

3. Fill in the requested information before you dial.

After you are connected to your ISP, use the Inbox program to send and receive e-mail, as explained in “Using Inbox” on page 61.

If you are unable to find an analog phone line, use the line dedicated to a fax machine. Fax machines use only analog lines.

Setting up an Ethernet connection

The HP Jornada can also connect to networks via Ethernet cards (CompactFlash Type II cards). Check the manufacturer’s installation instructions for information on how to set up the connection.
Using Inbox

In Inbox on your P/PC, tap Compose, Options, the Services tab, and then the Add button. A setup wizard walks you through the steps.

To download your messages from the server

1. Tap Service, and select the connection you want to use.
2. Tap Connect to start downloading.

The mail that you receive using a dial-up connection appears in the Inbox folder on your P/PC, together with the mail you synchronize with your desktop computer. Messages that you receive remotely are linked to your mail server rather than your desktop computer.

You can work online, which means that you read and respond to messages while connected to the server. Messages are sent as soon as you tap Send, which saves space on your P/PC.

You can also work offline. Once you have downloaded new message headers or partial messages, you can disconnect from the server and then decide which messages to download completely. The next time you connect, Inbox downloads the complete messages you have marked for retrieval and sends the messages you have composed (see "Receiving messages" for details).
Receiving messages
When you receive a message, double-tap it to open it.

When you connect to your Internet mail service, by default Inbox downloads only the first 100 lines of each new message to the Inbox folder. No mail attachments are downloaded. When you synchronize with your desktop computer, only the first 50 lines of each new message are downloaded. The original messages remain on the mail server or your desktop computer.

You can mark the messages that you want to retrieve in their entirety the next time you synchronize or connect to your mail service. Select the message, tap Service, and then tap Retrieve Full Copy. The icons in the Inbox message list give you visual indications of message status.
You specify your downloading preferences when you set up the service or select your synchronization options. You can change them at any time.

To change Inbox delivery options for mail synchronization, in the Mobile Devices window on your desktop computer, select your P/PC icon, click Tools, and then click ActiveSync Options. Select Message and then click Options. (For the Options button to be available, you must have previously enabled message synchronization.)

To change Inbox delivery options for remote mail, in Inbox on your P/PC, tap Service and then tap the service name. Then tap Service again and tap Properties.

You need to download a full message before you can view its attachments.

Microsoft Exchange users can use Inbox to schedule meetings remotely. Your network administrator must enable Microsoft rich text support for any accounts that are accessed by mobile device users.

To process meeting requests, you need to download the complete message, either by marking specific messages for downloading or by choosing to download all messages completely during the service setup. In addition, make sure to enable the Meeting requests option during the service setup.
Sending messages

To compose a new message, tap the **New Message** button on the toolbar. You can enter an e-mail address in the **To** box, or you can select a name from the Address Book. All e-mail addresses entered in the e-mail fields in Contacts appear in the Address Book.

To send your message, tap **File** and then **Send**. Messages are placed in your Outbox folder on your P/PC and are delivered to their destination in one of two ways.

They are transferred to the Outbox folder in Exchange or Outlook on your desktop computer the next time you synchronize.

They are transmitted to your mail server the next time you connect remotely. In Inbox, make sure the appropriate service is selected on the **Service** menu. Then tap **Connect**.

Display the Address Book.

To: stephanie@microsoft.com
CC: < ... >
BCC: < ... >
Subject: < ... >
Size: 26 Character(s)
Reply: < ... >
Service: Windows CE Inbox Service

Tap to display or hide the complete header.
Sending and receiving CompuServe e-mail

If you are a member of CompuServe, you can use Inbox to receive your CompuServe e-mail on the HP Jornada. To do this, you need to:

- Use the Web browser and Internet account on your desktop PC (partner) to go to the CompuServe Web site at www.csi.com/communications.

- Follow the instructions that are provided at that site for creating a POP3 mailbox. Be sure to choose a mailbox password that the HP Jornada can support (that is, clear text).

- Create a connection on the HP Jornada, as described in “Setting up a dial-up connection to your ISP” on page 59. You have all the account information you need when you finish creating your POP3 mailbox at the CompuServe site.

- Set up (and name) the Inbox mail service connection. See “Using Inbox” on page 61.

After you have completed these initial setup procedures, you are able to send and receive your CompuServe e-mail just as you would with any other Internet e-mail account.
Hewlett-Packard Jornada 420 Palm-size PC
6 | Staying Organized

The Hewlett-Packard Jornada 420 comes with programs designed to help you stay organized. You can manage your contacts, tasks, and calendar while you are away from your office. When you return, you can synchronize the HP Jornada with your desktop or notebook PC to ensure that the databases on the HP Jornada are always up to date with the Microsoft Outlook or Schedule+ data on your desktop.

You can also set alarms and reminders so you never forget an appointment or meeting, and you can record voice memos to yourself with Microsoft Voice Recorder. This chapter contains information about and basic procedures for:

- Calendar
- Contacts
- Tasks
- Voice Recorder

Calendar, Contacts, and Tasks have a card view and a list view. Card view allows you to enter or view the details for each entry. List view allows you to view all entries.

You can switch to these programs at any time by tapping them on the Start menu.

More information on the procedures described in this chapter, as well as information on additional procedures, can be found in online Help on the P/PC. Tap Start, Help, and then the item you want information on.
Scheduling meetings and appointments

Use Calendar to schedule appointments, meetings, and other events. Check your appointments in one of several views (Day, Week, Month, Year, and Agenda). Switch among the views by tapping the corresponding command bar button.

You can display today’s appointments on your Active Desktop. Tap Start, Settings, Display, Display Active Desktop, and then select Appointments.

Enter the details for an appointment on the appointment card.

You can quickly display a new appointment card by double-tapping the Calendar hard icon.
If you need to schedule a meeting with people who use Outlook, Pocket Outlook, or Schedule+, you can use Calendar to schedule the meeting. When attendees receive a meeting request, they can accept or decline the meeting. If they accept, the meeting is automatically added to their schedule. In addition, their response is automatically sent back to you, and your calendar is updated.

Before you can send a meeting request, you need to enter e-mail addresses in Contacts and set up Inbox to send and receive messages. For information on using Contacts and Inbox, see “Tracking friends and colleagues” on page 70, and “Using Inbox” on page 61.

To create a meeting request

1. Tap **Tools, Options**, and then select a mail transport. If you send and receive messages using synchronization, select **Windows CE Inbox Services**. If you connect to an ISP or network, select the service you set up in Inbox.
2. Tap **File** and then **Make Meeting**.
3. Enter the meeting information.
4. Select the contacts you want to invite.
5. Select other desired options and then **OK**.
Inbox automatically creates a meeting request and sends it to the attendees the next time you connect to your mail server or synchronize with your desktop computer.

Your P/PC reminds you about your appointments and meetings by sounding an alarm, flashing the notification light, or displaying a message on the screen. To change how you are notified, tap Tools and then Options. Tap the Alarm button and then Reminder Options.

**Tracking friends and colleagues**

Contacts maintains a list of your friends and colleagues so that you can easily find the information you are looking for, whether at home or on the road. Using the P/PC IR port, you can also quickly share Contacts information with other Windows CE-based mobile device users.

You can quickly create a contact card by double-tapping the Contacts hard icon.

Enter the details for a contact on the contact card. You can enter both business and personal information.

To change the type of information that appears in your list, tap Tools and then Customize Columns.
Keeping a to-do list

Use Tasks to keep track of what you have to do. Overdue tasks are displayed in red.

Enter the details for a task on the task card. You can assign a task to a category, and if you associate a date with a task, you can set a reminder for it.
All active tasks (tasks that have a start date before the current date and are not marked completed) are displayed in the Active Tasks box in the Agenda view of Calendar.

Display your active tasks on the Active Desktop. For more information, see “Using the Active Desktop” on page 23.

**Recording voice memos**

Quickly capture thoughts and reminders, ideas, and phone numbers with Voice Recorder. Use it in the way that is most convenient for you: using the hardware buttons on your P/PC or using the buttons on your screen.

You can use the buttons on your P/PC to record and play recordings one-handed.

**Making a recording**

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record</td>
<td>Press and hold the Record button. You hear one beep when it is ready to record.</td>
</tr>
<tr>
<td>Stop recording</td>
<td>Release the Record button. You hear two beeps when recording stops.</td>
</tr>
</tbody>
</table>
Playing a recording

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Play</td>
<td>Press the Action button.</td>
</tr>
<tr>
<td>Pause/resume</td>
<td>Press the Action button.</td>
</tr>
<tr>
<td>Stop</td>
<td>Press the Exit button (returns to the beginning of the recording).</td>
</tr>
<tr>
<td>Play all</td>
<td>Press the Action button twice (plays all messages in the list).</td>
</tr>
</tbody>
</table>

Navigating

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fast-forward, while playing</td>
<td>Press and hold the Action button in the down position.</td>
</tr>
<tr>
<td>Rewind, while playing</td>
<td>Press and hold the Action button in the up position.</td>
</tr>
<tr>
<td>Scroll through the list of recordings</td>
<td>Press the Action button up or down and then quickly release.</td>
</tr>
</tbody>
</table>

Using the screen buttons

Instead of using the P/PC buttons, you can tap the buttons on your screen to record and play your recordings. A progress bar and a status bar provide visual indications of the process.
To skip part of a recording, move the slider to any place in the recording before you play it.

Adjusting memory

If your P/PC runs out of memory while recording, you hear several beeps and see an out-of-memory message on your screen. You can adjust the allocation of memory on your P/PC by tapping Start, Settings, System, and then the Memory tab.

If you run out of memory frequently, use a CompactFlash Memory Card for storing files that you rarely need. For more information on CompactFlash Memory Cards, see “Inserting and Removing CompactFlash Cards” on page 92. To save a recording to a CompactFlash card, tap the Tools menu, and then tap Options. On the General tab, tap the Save to storage card check box, and then tap OK.
Voice Recorder uses approximately 300 bytes per second for recording, using the Mobile Voice format. For example, a 10-second note uses approximately 3K.

Choosing a recording format
Voice Recorder uses a codec called Mobile Voice to compress files, making them 25 times smaller than the original size. This enables you to store more recordings, although the sound quality is less than optimal. For the best sound quality, use the PCM format. These files are larger than those stored in Mobile Voice format. To switch formats, tap Tools and then Recording Format.

Your recordings are saved as .wav files, which you can transfer to your desktop computer for playback, editing, and archiving. You need desktop software that can play .wav files, and you need the same codec used to make the recording. You can get the Mobile Voice codec by installing Windows CE Services (see “Understanding Windows CE Services” on page 39) or go to the following Web site: http://www.microsoft.com/windowsce/info/.

If you want to email your recording from your P/PC, use the PCM file format.

Organizing recordings
Your recordings are saved automatically and given the names Recording1, Recording2, and so on, by default. These recordings are listed in the Voice Recorder window.

To quickly rename a recording
1. Tap the recording to select it.
2. Tap it again, and then enter the new name.

You can organize your recordings by renaming them and placing them in folders. For example, you can create a folder called My Novel and place all relevant recordings in that folder.

If you display recordings for a particular folder in the Voice Recorder window, any new recordings you make while that folder is selected are placed in that folder. They are given the folder name.
name and an incremental number (My Novel1, My Novel2, and so on).

<table>
<thead>
<tr>
<th>Name</th>
<th>Date</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>Autumn's</td>
<td>1/9</td>
<td>15:43</td>
</tr>
<tr>
<td>Family</td>
<td>1/8</td>
<td>15:43</td>
</tr>
<tr>
<td>My Novel</td>
<td>1/9</td>
<td>15:44</td>
</tr>
</tbody>
</table>

- Rename a file and place it in a folder.
- Display the contents of the selected folder.
- Create and delete folders.
- Sort the list on a column.
The Hewlett-Packard Jornada 420 can help you stay productive and be efficient, even when you are away from your desktop or notebook PC. You have access to pre-installed programs to help you calculate expenses and conduct searches.

This chapter contains information about:

- Microsoft Note Taker
- bTASK from BSQUARE
- OmniSolve from LandWare
- HP backup
- Customizing the HP Jornada

Creating notes and drawings

Note Taker with Rich Ink technology makes it easy to write, draw, and make lists quickly, the way you are used to writing on paper—but even better, because you can edit and format what you have written or drawn.

To use Note Taker, tap **Start**, then **Note Taker**.

You can create a new note by tapping the **New** button, or you can tap the **New** arrow and tap a template to start with a note in which the formatting and structure are already in place.
Entering information

With Note Taker, you can enter information in the way that is easiest for you. You can use the input panel to type using the keyboard, or you can write using the character recognizer. You can also write and draw directly on the screen.

When you display the input panel, you see the insertion point, indicating where the text is placed.
When you hide the input panel, the insertion point disappears, and you can write or draw anywhere on the screen.

Writing and drawing
You can use your stylus to write and draw directly on the screen.

To create a drawing, on your first stroke, cross three ruled lines. A drawing box appears. Subsequent strokes in or outside the border of the drawing box become part of the drawing.

You might want to switch to full-screen display so that you can see as much as possible on the screen. Tap View, then Full Screen. Tap Restore to see the command bar again.

Editing and formatting a note
You can edit text you have entered using a keyboard or character recognizer. You can also edit handwritten notes and drawings. To select the text or picture you want to edit, hide the input panel, tap the Select button, and drag your stylus over the text or drawing.
Instead of tapping the Select button, you can press and hold the Action button as you drag the stylus.

Tap the Edit button to see your editing options. The options available depend on what you have selected: text, handwriting, or a drawing.

You can apply formatting to a selection, or you can set default formatting that is applied to everything you then type, write, or draw.

You can also use the Space button to increase or decrease the space between elements on your screen.

First tap the Space button.

Then, tap and drag to the right or down to insert space.
Tap and drag to the left or up to close space.
Instead of tapping the **Space** button, you can insert and remove space by pressing and holding the **Exit** button as you drag the stylus.

**Saving your notes**

When you have finished a note, tap **OK** to save it and return to your list of notes. Note Taker automatically names your note as follows.

The first 21 characters of the first line of typed text are used as the note name.

If no text is included in the note, but the note has been assigned to a folder, the notes are given the folder name and an incremental number (Tradeshow1, Tradeshow2, and so on).

If no text is included and no folder is assigned, the notes are named **Note1**, **Note2**, etc.

To name a note yourself, to place it in a folder, or to change the file format, tap **File** and then **Save As**.

![Save As](image)

Each note in Note Taker is a file. Note Taker files are saved in Note Taker (.pwi) format, which synchronizes with Microsoft Word files, as described in Chapter 6. You have two additional choices for file formats:

To import the file into a program that supports rich text, save the note in **Rich text format** (.rtf). Handwritten words and drawings are lost.

To import the file into a program that does not support rich text, save the note as a **Text only note** (.txt). Handwritten words and drawings, and all formatting, are lost.
Organizing your notes

You can keep track of your notes by renaming them and placing them in folders. For example, you can create a folder called My Novel and place all relevant notes in that folder. All the notes in the selected folder appear in the list view.

<table>
<thead>
<tr>
<th>Name based on the first typed text in the note</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name based on a template</td>
</tr>
<tr>
<td>Default name for handwritten note, based on folder name</td>
</tr>
</tbody>
</table>

Using bTask

Use bTask to switch between applications, view the applications currently running, or close applications with a single step.

Tasks are closed automatically when memory is running low.

To start bTask

1. From the Start menu, tap Programs, and then tap bTask. The bTask icon is added to the taskbar.

To switch between open applications

1. Tap the bTask icon on the taskbar.
2. Tap the application to which you want to switch.

To close the active application or all open applications

1. Tap the bTask icon on the taskbar.
2. Tap Close Active or Close All.
To close bTask
1. Tap the bTask icon on the taskbar.
2. Tap Exit.

**Using OmniSolve**

OmniSolve is a financial application designed specifically for real estate, retail, and business professionals who use P/PCs to make financial decisions quickly and accurately. OmniSolve employs a “form filling” metaphor to give you a problem-solving environment that is easy, powerful, and flexible.

To start OmniSolve
1. From the Start menu, tap Programs, and then tap OmniSolve.

For detailed procedures about using OmniSolve, refer to online Help.

**Backing up and restoring data**

To prevent loss of data, you should back up the HP Jornada data frequently. You can back up the HP Jornada two convenient ways:

- Use Windows CE Services to back up all data to your desktop PC.
- Use the HP backup application to back up all data or only Calendar, Task, and Contact (PIM) databases to internal memory or a CompactFlash Card.

**Using Windows CE Services Backup at your PC**

The Windows CE Services Backup feature creates a complete duplicate of all data stored on the HP Jornada. If you routinely connect to your desktop PC, this is the best method of data backup. The backup file is saved on the hard disk of your desktop PC.

When you restore data from a backup file created by Windows CE Services, all data on the HP Jornada is replaced by
the data in the backup file, including files you have created, programs you have installed, and any system settings and options you have set.

To access the Windows CE Services Backup feature, click **Backup/Restore** on the **Tools** menu in the Mobile Devices window.

**Using HP backup**

HP backup provides a convenient way to back up data while you are traveling or while you are away from your desktop PC. You can back up the information to a CompactFlash Card for secure storage. You can also back up data to a folder on the HP Jornada. However, this does not preserve the information if you lose power or need to perform a full reset.

The backup file (.dbe or .dbb) is always placed in the My Documents directory. When saving to a CompactFlash Card, a My Documents directory is automatically created.

**To back up data**

1. On the **Start** menu, tap **Settings**, and tap **HP backup**.

![HP backup window](image)

With HP backup, you can back up data to external or internal memory. 
Caution: Backing up data to internal memory will not preserve your data if your P/PC loses power or a full reset is performed. Back up to external memory to ensure the safety of your data.

First, exit all applications and disconnect P/PC from the desktop PC. Then, click Backup or Restore to proceed.
2. Tap **Backup**, and then choose one of the backup options:

- Select **Backup all data** to back up all information stored in RAM, including files you have created, programs you have installed, and any system settings and options you have set.

- Select **Backup PIM databases** to back up only your Contacts, Tasks, and Calendar databases.

3. Follow the instructions on your screen to complete the backup process.

**To restore from a backup file**

1. On the **Start** menu, tap **Settings**, and tap **HP backup**.
2. Tap **Restore**.
3. Tap either **Restore all data** or **Restore PIM databases**.
4. Select the backup file you want to restore, and then tap **OK**.
The HP Jornada must have the same regional settings when you restore as you had when you completed the backup. Otherwise, you cannot restore the files. To change regional settings, on the Start menu, tap Settings, and then tap Regional Settings.

Customizing the HP Jornada

This section describes ways you can add software and accessories to the HP Jornada.

Finding third-party software

You can add more capabilities to the HP Jornada by installing third-party software. A variety of commercial software is available for Windows CE, including custom business applications, system utilities, and games.
You can get these programs from:

- the HP Jornada compact disk and the Desktop Software for Microsoft Windows CE compact disk included with the HP Jornada
- software distributors and their web sites, including the HP web site at www.hp.com/jornada/solutions/solution.html

You cannot run programs designed for Windows 95 or Windows NT on the HP Jornada. The programs that run on the P/PC must be designed specifically for Windows CE Palm-size PCs.

Contents of the HP Jornada compact disk

The HP Jornada compact disk includes the following programs:

- Outside In from Inso—View Microsoft Word files (with graphics) from your P/PC.
- Quicken ExpensAble from On-The-Go Software—Create expense reports while on the road.
- PhoneManager 2.0 from Trio—Send and receive SMS messages via GSM phone, and manage the handphone directory from P/PC.
- PIM Translation Utility from Hewlett-Packard—Translate Appointments and Phone Book data from older HP electronic organizers for use in your HP Jornada.

Explore the HP Jornada compact disk to enjoy these free programs. For more information about a particular program, go to the program manufacturer's website.

Minimum PC requirements for HP Jornada compact disk

The minimum PC requirements for the HP Jornada compact disk are as follows:

- Microsoft Windows 95, Windows 98, or Windows NT 4.0
- 486 66MHz or faster processor
- 2x or faster CD-ROM drive
Hewlett-Packard Jornada 420 Palm-size PC

- VGA (640 x 480) 256-color monitor
- Web browser: Netscape Navigator 2.0 or higher, or Microsoft Internet Explorer 2.0 or higher.

To install a program

1. Download the software program or installer from the Web to your desktop PC.
   - or -
   Insert the floppy disk or compact disk into the appropriate drive on your desktop PC.
2. Connect the HP Jornada to your desktop PC.
3. If the program includes an installer program (typically named Setup.exe or Install.exe), double-tap the installer program on the desktop PC. The installer program copies the necessary files to the HP Jornada.
   - or -
   If the program does not have an associated installer or setup program, drag the program file (typically an *.exe file type) to the HP Jornada icon in the Mobile Devices window. If the No Converter Selected dialog box appears, tap OK to copy the file without conversion.

Install software by dragging the program file to the Mobile Devices window only if no installer program is available. Software installed in this way may not appear on the Remove Programs list, and you may have to delete the program manually if you wish to remove it from the HP Jornada.

To add programs with Application Manager

1. Connect the HP Jornada to your desktop PC, and then open the Mobile Devices window.
2. On the Tools menu in the Mobile Devices window, click Application Manager.
3. In the list of programs, select the program you wish to install, and then click Add.
Removing programs

After you have installed a program on the HP Jornada, you can use the Windows CE Application Manager to remove the program or to reinstall the program after it has been removed. If you do not have enough storage memory on the HP Jornada, you may want to use the Application Manager to temporarily remove programs you no longer use or programs that you use infrequently.

You can use either the Application Manager (on your desktop PC) or the **Remove Programs** control panel (on the HP Jornada) to remove programs.

**To remove programs with Application Manager**

1. Connect the HP Jornada to your desktop PC, and then open the Mobile Devices window.
2. On the **Tools** menu in the Mobile Devices window, click **Application Manager**.
3. In the list of programs, select the program you want to delete, and then click **Remove**.

**To remove programs from the HP Jornada with the Remove Programs control panel**

1. On the **Start** menu, tap **Settings**, and then tap **Remove Programs**.
2. From the **Programs** list, select the program you want to remove.
3. Tap **Remove**.

Programs stored in ROM cannot be removed. (For a list of these programs see “Using HP Jornada’s built-in programs” on page 3.)
Adding sounds
The HP Jornada plays sounds (.wav files). You can copy a new sound file from your desktop PC to the HP Jornada without converting the file.

To add sounds
1. Connect the HP Jornada to a desktop PC and start Windows CE Services.
2. Double-click the HP Jornada icon.
3. Drag the .wav file you want to copy from its location on your desktop PC to the Windows folder in the Mobile Devices window.

To use the new sound
1. On the HP Jornada Start menu, tap Settings, and then tap Volume & Sounds.
2. Tap the Sounds tab.
3. Choose an event name from the first dropdown list.
4. Choose the new sound from the second dropdown list.
5. Tap OK.

Adding desktop wallpaper
The HP Jornada can display Windows CE bitmaps (.2bp files). You can copy Windows CE bitmap images from your desktop PC to the HP Jornada without converting the files, and you can use these images as desktop wallpaper on your Windows CE desktop.

To add desktop wallpaper
1. Connect the HP Jornada to a desktop PC and start Windows CE Services.
2. Double-click the HP Jornada icon.
3. Drag the bitmap image you want to copy from its location on your desktop PC to the Windows folder in the Mobile Devices window.
To use the new wallpaper

1. On the HP Jornada Start menu, tap Settings, and then tap Display.
2. Choose the Display wallpaper radio button.
3. Choose the new bitmap image from the Wallpaper image dropdown list, and examine the preview image on the right side of the dialog box.
4. If desired, tap the Tile checkbox.
5. Tap OK.

Adding accessories
You can purchase the following optional accessories.

- CompactFlash Card and adapter (4MB) (F1231A)—Adds storage memory.
- CompactFlash Card and adapter (10MB) (F1233A)—Adds storage memory.
- Sync Cable (F1258A)
- External keyboard (F1275A)
- Battery Pack (F1287A)
- Pens (F1288A)
- Cradle (F1289A)
- AC Adapter (F1290A)
- External charger (F1293A)

Go to the Hewlett-Packard website at www.hp.com/jornada to check for new accessories.
Inserting and Removing CompactFlash Cards

CompactFlash Type I and II Cards give the HP Jornada additional capabilities, such as additional memory, removable storage, cellular modems, and Ethernet cards. Many cards have been tested specifically for compatibility with the HP Jornada. For a list of recommended compatible devices, go to the Hewlett-Packard Web site at www.hp.com/jornada.

You may also need to install a software driver for a particular card. The software drivers for Windows CE should be included with the card or be available from the card manufacturer.

To insert the CF card

1. Turn off the P/PC, and close the display cover.
2. Remove the CF card slot door by pressing onto the fingernail recess and pulling the door off.
3. Connect the P/PC to AC power by mounting it into the cradle.
4. Push the card, connector-side first, into the slot until it stops. The P/PC turns back on.
5. Replace the card slot door by positioning the two tabs in the slot groove and pressing onto the fingernail recess to push the door locked.

View showing how to insert a CF card
To remove the CF card

1. Close all applications on the P/PC that have open files on the CF card.

2. Turn off the P/PC, and close the display cover.

3. Remove the CF card slot door by pressing onto the fingernail recess and pulling the door off.

4. Use the end of the stylus to lever the CF card out.

5. Replace the card slot door by positioning the two tabs in the slot groove and pressing onto the fingernail recess to push the door locked.
94 Hewlett-Packard Jornada 420 Palm-size PC
If you encounter difficulties while using your HP Jornada 420, this chapter helps you find answers. If you need information about troubleshooting Microsoft® Windows® CE Services, click Windows CE Services Help Topics on the Help menu in the Mobile Devices window on your desktop PC.

The information in this chapter helps you:

- Troubleshoot basic problems
- Troubleshoot problems with remote connections
- Troubleshoot problems with the display
- Troubleshoot problems connecting by infrared

### Troubleshooting basic problems

If you have a specific problem, review the information below to see if you can find the answer quickly. Or, go to the HP Jornada Web site at www.hp.com/jornada for current information about common difficulties.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Diagnosis / Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP Jornada does not turn on when not connected to AC power.</td>
<td>Battery power is too low to run the P/PC. Connect to AC power, and then turn on your HP Jornada. (Charge the battery regularly to avoid running out of battery power.)</td>
</tr>
<tr>
<td>Battery runs out of power quickly.</td>
<td>You are using your HP Jornada in ways that drain the batteries quickly. See “Managing battery power” on page 16.</td>
</tr>
<tr>
<td>Issue</td>
<td>Solution</td>
</tr>
<tr>
<td>-------</td>
<td>----------</td>
</tr>
<tr>
<td>HP Jornada does not auto-suspend when connected to a desktop PC or when using the modem.</td>
<td>The HP Jornada is designed to stay on while connected to a computer. This is the correct behavior. No action is needed.</td>
</tr>
<tr>
<td>HP Jornada automatically shuts down.</td>
<td>Batteries are too low to run the P/PC. When a critically low battery-power condition is encountered, the HP Jornada initiates a safety shutdown. Connect to AC power and charge the battery.</td>
</tr>
<tr>
<td>HP Jornada does not turn on when connected to AC power.</td>
<td>HP Jornada is locked up. Connect the HP Jornada to external power, and perform a soft reset. (See “Resetting” on page 99.) (Caution: You may lose any unsaved data when performing a soft reset.)</td>
</tr>
<tr>
<td>HP Jornada locks up when running applications.</td>
<td>HP Jornada is locked up. Connect to AC power, and perform a soft reset. (See “Resetting” on page 99.) Note: Check battery power regularly to ensure that the battery is not running low on power.</td>
</tr>
<tr>
<td>HP Jornada does not turn on or display appears to be off, even though power is on.</td>
<td>The display contrast is too light. (For more information, see “Using HP settings” on page 31.)</td>
</tr>
<tr>
<td>Backup file created with the HP backup application on another HP handheld device cannot be restored to the HP Jornada 420.</td>
<td>File format is not compatible, or file cannot be found. Only a PIM database backup file (.dbb) can be restored from another HP handheld device to the HP Jornada 420. Make sure that you save the backup file (.dbb) in the My Documents directory on the other handheld device, and that the My Documents directory is copied to the CompactFlash Card used for the restore action.</td>
</tr>
</tbody>
</table>
Data is lost.
Main battery was removed for more than 1 minute. Do not remove the main battery except when replacing it with a spare one.
HP Jornada was not charged for more than 2 weeks. Without charging data will be retained for up to 2 weeks.
A hard reset (cold boot) was performed. Backup regularly and make sure you backup before storing your HP Jornada for longer periods.

Troubleshooting remote connections
This section offers troubleshooting help for trying to connect your HP Jornada to other computers. For problems communicating with your desktop, see Windows CE Services Help.

Able to dial out, but unable to make a proper connection
- Make sure the network to which you are trying to connect supports Point-to-Point Protocol (PPP). Your Internet service provider or network administrator can verify this.
- Verify that the location is correct. Tap Start, Settings, then Dialing. Make sure that the Location field reflects your current location; that the location’s dialing pattern is appropriate; and that the local country and area code are correct.

Connection is unreliable
- Make sure the modem is firmly seated and connected to your device and the telephone jack.
- Disable call waiting. Tap Start, Settings, then Dialing. Select Disable call waiting. Then enter the disable code specified by your telephone company.
Unable to use infrared transfer between Windows CE-based devices

If you are unable to use infrared to transfer information between Windows CE-based devices, try the following.

- Transfer only one file, or no more than 25 contact cards, at a time.
- Position the infrared ports so that they line up and are less than 20 centimeters (8 inches) but more than 2 inches apart.
- Make sure nothing is between the two infrared ports.
- Adjust the room lighting. Some types of light interfere with infrared communication. Try moving to a different location or turning off some lights.

Troubleshooting viewing problems

If you are having trouble viewing your data, here are some suggestions.

Screen is blank

If the device does not respond when you briefly press the On button:

- Make sure your battery cover is locked.
- Adjust the display contrast. On some devices, the screen can darken or lighten to the point that it appears to be powered off. For information on adjusting contrast, see “Setting brightness, contrast, and volume” on page 31.
- Reset the device.
- Charge the main battery by connecting to AC power.

Screen is dark

Prolonged exposure to direct sunlight may cause your device screen to temporarily darken. This is normal for LCD screens and is not permanent.
Screen is hard to read
The display can be hard to read if the P/PC has been off for a long time. The display returns to normal after using it for about 1 minute.

If you are having a hard time viewing a Note Taker document, try changing the size of the view. To do this, tap the Zoom arrow on the command bar and select a zoom percentage.

If you are having a hard time viewing Calendar, Tasks, or Contacts data, try enlarging the display font. To do this within Calendar, Tasks, or Contacts, tap **Tools**, **Options**, and then select **Use large font**.

**Resetting**
Occasionally, you may need to reset the HP Jornada; for example, you may reset after you restore data from your desktop PC or when the operating system stops responding.

There are two methods of resetting:
- **Soft reset**—A soft reset (also called “warm boot”) is similar to restarting your desktop PC. It restarts the operating system and preserves any saved data, but loses any unsaved data.
- **Full reset**—A full reset (also called “cold boot”) restores the HP Jornada to its original state, erasing all information, including saved and unsaved data, you have entered.

To ensure the safety of your information in case a full reset is necessary, you should regularly back up your data to your desktop PC (using Windows CE Services) or to a CompactFlash Card (using the HP backup application). For more information on backing up data, see “Backing up and restoring data” on page 83.

**Soft reset**
Perform a soft reset after restoring data from a backup file or when the HP Jornada appears to be “frozen” or “locked up.”

When you perform a soft reset you lose unsaved data in all open documents or programs. To close all open documents and programs, use bTask as described in “Using bTask” on page 82.
To perform a soft reset

1. Use the stylus to press the Reset button on the back of the HP Jornada, as illustrated above.

Full reset
Perform a full reset only when the HP Jornada does not respond to a soft reset. A full reset erases all data you have entered, including all files, system settings, and programs you have installed. If you have forgotten your password, you also need to perform a full reset.

Performing a full reset erases all files, programs, and data you have entered. You can restore only data that has been backed up to your desktop PC or CompactFlash Card. (For more information, see “Backing up and restoring data” on page 83.)

To perform a full reset

1. Disconnect the AC adapter from the HP Jornada.
2. Remove the battery.
3. Use the stylus to press the Reset button for at least 5 seconds.
4. Reinsert the battery.
5. Restore data to the HP Jornada from your most recent backup file. For more information, see “Backing up and restoring data” on page 83.
9 | Warranty, support, and service

Limited one-year warranty
The HP Jornada model 420 comes with a limited one-year warranty.

What is covered
The HP Jornada model 420 (including the rechargeable backup battery) and accessories are warranted by Hewlett-Packard against defects in materials and workmanship for one year from the date of original purchase. If you sell your P/PC or give it as a gift, the warranty is automatically transferred to the new owner and remains in effect for the original one-year period beginning at the time of purchase. During the warranty period, we will repair or, at our option, replace at no charge a product that proves to be defective, provided you return the product, shipping prepaid, to a Hewlett-Packard service center. (Replacement may be made with a new or reconditioned P/PC, or with a newer model of equal or better functionality.)

This warranty gives you specific legal rights, and you may also have other rights that vary from state to state, province to province, or country to country.

What is not covered
This warranty does not apply if the product:

- has been damaged by accident or misuse, or as the result of service or modification by other than an authorized Hewlett-Packard service center.
• has been opened for any reason except to perform an official upgrade using an HP Upgrade Kit.

No other express warranty is given. The repair or replacement of a product is your exclusive remedy. ANY OTHER IMPLIED WARRANTY OR MERCHANTABILITY OR FITNESS IS LIMITED TO THE ONE-YEAR DURATION OF THIS WRITTEN WARRANTY. Some states, provinces, or countries do not allow limitations on how long an implied warranty lasts, so the above limitation may not apply to you. IN NO EVENT SHALL HEWLETT-PACKARD COMPANY BE LIABLE FOR CONSEQUENTIAL DAMAGES. Some states, provinces, or countries do not allow the exclusion or limitation of incidental or consequential damages, so the above limitation or exclusion may not apply to you.

Products are sold on the basis of specifications applicable at the time of manufacture. Hewlett-Packard shall have no obligation to modify or update products, once sold.

Consumer transactions in Australia, New Zealand and the United Kingdom

The preceding disclaimers and limitations shall not apply to consumer transactions in Australia, New Zealand and the United Kingdom, and shall not affect the statutory rights of consumers.

For consumers in Australia

The above warranty terms and any other warranty statement enclosed with this product, except to the extent lawfully permitted, do not exclude, restrict, or modify and are in addition to the statutory rights implied by the Trade Practices Act 1974 or any corresponding State or territory legislation applicable to the sale of this product to you. If you have any queries about your rights, contact the Hewlett-Packard Customer Care Center at 61-3-88778000.

For consumers in New Zealand

The above warranty terms or any other warranty statement enclosed with this product, except to the extent lawfully permitted, do not exclude, restrict or modify and are in addition to the statutory rights implied by the Consumer Guarantees Act.
1993 applicable to the sale of this product to you. If you have any queries about your rights contact the Hewlett-Packard End User Support line at 0800-733547.

Year 2000 warranty
Subject to all of the terms and limitations of the HP Limited Warranty Statement provided with this HP Product, HP warrants that this HP product will be able to accurately process date data (including, but not limited to, calculating, comparing, and sequencing) from, into, and between the twentieth and twenty-first centuries, and the year 1999 and 2000, including leap year calculations, when used in accordance with the Product documentation provided by HP (including any instructions for installing patches or upgrades), provided that all other products (e.g. hardware, software, firmware) used in combination with such HP product(s) properly exchange date data. The duration of the Year 2000 warranty extends through January 31, 2001.

HP makes no representation or warranty respecting the accuracy or reliability of information about non–HP products. Such information is provided by the manufacturers of those products, and customers are urged to contact the manufacturer directly to verify Year 2000 readiness.

Customer support
If you have questions that this User’s Guide does not answer (after checking the contents and index), you can contact Hewlett-Packard Worldwide Support and Services for Handheld Products at the telephone numbers listed in the following table. If the P/PC requires service, contact Hewlett-Packard for service information, shipping instructions, and out-of-warranty service charges before you send your P/PC to HP for repair. In countries not listed in the table, contact the Hewlett-Packard authorized dealer or sales office.

Service
For diagnostic instructions and other service information, contact one of the technical support numbers listed. Please do not ship your P/PC for service without first contacting a Hewlett-Packard office. If your P/PC qualifies for in-warranty service, be ready to supply a dated proof of purchase.
In countries not listed in the following table, contact the Hewlett-Packard authorized dealer or sales office. Before you contact us for help, be sure to:

1. Review the manuals whenever possible.
2. Have the following information about the product:
   - Model number
   - Serial number
   - Purchase date
3. Have your product ready to use. The support personnel may ask you to run tests and other operations.
4. Organize your question or problem. The more detailed information you can provide, the quicker the support personnel can help you.

Web site
You can also obtain product information as well as tips and hints on how to get more from the HP Jornada product at our worldwide Web site. This computer service is provided free of charge; you pay only for telephone charges and Internet service fees. To connect to this Web site from a computer via the Internet, go to www.hp.com/jornada.

Contacting Hewlett-Packard worldwide
You will be pleased to know that our commitment to quality does not stop at the sale. Our worldwide customer support network is available to give you personal telephone service should you need it.

<table>
<thead>
<tr>
<th>Country/Region</th>
<th>Telephone</th>
</tr>
</thead>
<tbody>
<tr>
<td>Argentina</td>
<td>54-1-7788380</td>
</tr>
<tr>
<td>Australia</td>
<td>61-3-88778000</td>
</tr>
<tr>
<td>Austria</td>
<td>43-711-4201080</td>
</tr>
<tr>
<td>Belgium (Dutch)</td>
<td>32-2-6268806</td>
</tr>
<tr>
<td>Belgium (French)</td>
<td>32-2-6268807</td>
</tr>
<tr>
<td>Country</td>
<td>Phone Number</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-----------------------</td>
</tr>
<tr>
<td>Brazil</td>
<td>55-11-8296612</td>
</tr>
<tr>
<td>Canada</td>
<td>1-905-2064663</td>
</tr>
<tr>
<td>Chile</td>
<td>56-800-360999</td>
</tr>
<tr>
<td>China</td>
<td>86-10-65645959</td>
</tr>
<tr>
<td>Czech Republic</td>
<td>420-2-61307310</td>
</tr>
<tr>
<td>Denmark</td>
<td>45-39-294099</td>
</tr>
<tr>
<td>Finland</td>
<td>358-20347288</td>
</tr>
<tr>
<td>France</td>
<td>33-1-43623434</td>
</tr>
<tr>
<td>Germany</td>
<td>49-1-805258143</td>
</tr>
<tr>
<td>Greece</td>
<td>30-1-6896411</td>
</tr>
<tr>
<td>Hong Kong</td>
<td>800-967729</td>
</tr>
<tr>
<td>Hungary</td>
<td>36-1-3430310</td>
</tr>
<tr>
<td>India</td>
<td>91-11-6826035</td>
</tr>
<tr>
<td>Indonesia</td>
<td>62-21-3503408</td>
</tr>
<tr>
<td>Ireland</td>
<td>353-1-6625525</td>
</tr>
<tr>
<td>Israel</td>
<td>972-9-9524848</td>
</tr>
<tr>
<td>Italy</td>
<td>39-2-26410350</td>
</tr>
<tr>
<td>Japan</td>
<td>81-3-33358333</td>
</tr>
<tr>
<td>Korea</td>
<td>82-2-32700700</td>
</tr>
<tr>
<td>Malaysia</td>
<td>60-03-2952566</td>
</tr>
<tr>
<td>Mexico</td>
<td>52-1800-4726684</td>
</tr>
<tr>
<td>Netherlands</td>
<td>31-20-6068751</td>
</tr>
<tr>
<td>New Zealand</td>
<td>0800-733547</td>
</tr>
<tr>
<td>Norway</td>
<td>47-22-116299</td>
</tr>
<tr>
<td>Philippines</td>
<td>63-2-8673551</td>
</tr>
<tr>
<td>Poland</td>
<td>48-22-8659999</td>
</tr>
<tr>
<td>Portugal</td>
<td>351-1-4417199</td>
</tr>
<tr>
<td>Country</td>
<td>Phone</td>
</tr>
<tr>
<td>--------------</td>
<td>----------------</td>
</tr>
<tr>
<td>Russia</td>
<td>7-095-9169821</td>
</tr>
<tr>
<td>Singapore</td>
<td>65-2725300</td>
</tr>
<tr>
<td>South Africa</td>
<td>27-11-4481140</td>
</tr>
<tr>
<td>Spain</td>
<td>34-91-7820109</td>
</tr>
<tr>
<td>Sweden</td>
<td>46-8-6192170</td>
</tr>
<tr>
<td>Switzerland</td>
<td>41-848-801111</td>
</tr>
<tr>
<td>Taiwan</td>
<td>886-2-7170055</td>
</tr>
<tr>
<td>Thailand</td>
<td>66-2-6614011</td>
</tr>
<tr>
<td>Turkey</td>
<td>90-212-2245925</td>
</tr>
<tr>
<td>UK</td>
<td>44-870-6083003</td>
</tr>
<tr>
<td>USA</td>
<td>1-800-443-1254</td>
</tr>
<tr>
<td>Pre-sales Information</td>
<td>(toll-free, no operator is available)</td>
</tr>
<tr>
<td>Support &amp; Service</td>
<td>1-970-635-1000</td>
</tr>
<tr>
<td></td>
<td>Palmtops &amp; Organizers (toll call)</td>
</tr>
<tr>
<td>Venezuela</td>
<td>58-800-47888 or 58-2-2078488</td>
</tr>
</tbody>
</table>

All Customer Care Centers are available during office hours. Pre-sales Information in the USA is available 24 hours per day, 7 days per week. Support & Service in the USA can be contacted from 5 am to 5 pm Pacific Time, Monday through Friday.
The character recognition software, CIC Jot, gives you a fast and easy-to-use method for entering information in any program on your device: just write in the input panel. Each character you write is translated into typed text and displayed on the screen.

This appendix describes how to use the Jot character recognizer. It also provides tables showing how and where to draw characters on the screen for each of the two character sets: the Natural Character Set and the Simplified Uppercase Character Set.

Select character recognition as your input method by tapping the Input Method arrow on your taskbar and tapping Jot Character Recognizer.

Using your stylus, write a character in the input panel. The character is translated into typed text and displayed at the insertion point on the screen.
Areas of the Input Panel

You can write letters in either uppercase or lowercase. How the letter is interpreted and displayed depends on where you write it in the input panel. For example, you can write a letter in lowercase or uppercase, and it will appear in lowercase if you write it in the lowercase letter area (abc) of the input panel.
You can also write punctuation and editing marks, and add or delete space in the letter areas (abc and ABC) of the input panel. For example, draw a horizontal line from left to right to add space, and from right to left to backspace. See the tables at the end of this appendix for details.

You can write numbers in the number area (123) of the panel.

You can also enter common punctuation marks in the number area. This allows you to write telephone numbers, birthdays, and Social Security numbers entirely in the number area. See the tables at the end of this appendix for details.

**Symbols**

Enter symbols, such as @ or #, on the symbol input panel. Display the symbol panel by tapping the **Symb** button on the input panel or by drawing a vertical line from bottom to top, anywhere in the panel.

When you’ve drawn the symbol, wait and Jot will display the main panel again automatically, or tap the **Symb** button to return to the main panel immediately.
See the tables at the end of this appendix for a list of symbols that can be entered in this panel.

**Help Writing Characters**

The software recognizes several alternative ways of writing a character. If a character you are writing is misinterpreted, you can use Help to see an animated demonstration of how to write the letter. Tap the Help button on the input panel, and then tap Next. Select the character you want to see, and tap Show.

**Options**

You can adjust settings to suit the way you work. Tap Start, Settings, then Input Panel. Select Jot Character Recognizer as the input method, and then tap Options.

One of your options is to use the Simplified Uppercase Character Set. For more information about how and where to write characters using this character set, see “Simplified Uppercase Character Set” later in this appendix or select this character set in the Options dialog box and then tap the Help button on the input panel.

**Natural Character Set**

The tables in this section show how to use the Natural Character Set to write letters, numbers, punctuation marks, editing marks, and symbols. For each character, the tables show alternatives for writing the characters. The dots indicate where the strokes begin; strokes with no dots can be written in either direction. Where appropriate, the stroke sequence is numbered.

**Using the letter areas**

You can enter letters, punctuation, and editing marks in the letter areas (abc and ABC) of the input panel.
### Letters

<table>
<thead>
<tr>
<th>Character</th>
<th>Stroke options</th>
<th>Character</th>
<th>Stroke options</th>
</tr>
</thead>
<tbody>
<tr>
<td>a</td>
<td>aAAA</td>
<td>n</td>
<td>NNN</td>
</tr>
<tr>
<td>b</td>
<td>bBBB</td>
<td>o</td>
<td>OO</td>
</tr>
<tr>
<td>c</td>
<td>C</td>
<td>p</td>
<td>pP</td>
</tr>
<tr>
<td>d</td>
<td>dDDD</td>
<td>q</td>
<td>qQ</td>
</tr>
<tr>
<td>e</td>
<td>EE</td>
<td>r</td>
<td>RRR</td>
</tr>
<tr>
<td>f</td>
<td>fF</td>
<td>s</td>
<td>S</td>
</tr>
<tr>
<td>g</td>
<td>gGGGG</td>
<td>t</td>
<td>T</td>
</tr>
<tr>
<td>h</td>
<td>hhh</td>
<td>u</td>
<td>UU</td>
</tr>
<tr>
<td>i</td>
<td>i</td>
<td>v</td>
<td>Vv</td>
</tr>
<tr>
<td>j</td>
<td>jJUJ</td>
<td>w</td>
<td>W</td>
</tr>
<tr>
<td>k</td>
<td>kK</td>
<td>x</td>
<td>&quot;x&quot;</td>
</tr>
<tr>
<td>l</td>
<td>lL</td>
<td>y</td>
<td>yY</td>
</tr>
<tr>
<td>m</td>
<td>mm</td>
<td>z</td>
<td>Zz</td>
</tr>
</tbody>
</table>
Punctuation

<table>
<thead>
<tr>
<th>Character</th>
<th>Stroke options</th>
<th>Character</th>
<th>Stroke options</th>
</tr>
</thead>
<tbody>
<tr>
<td>period</td>
<td>•</td>
<td>at</td>
<td></td>
</tr>
<tr>
<td>comma</td>
<td></td>
<td>double quote</td>
<td>&quot;</td>
</tr>
<tr>
<td>apostrophe</td>
<td></td>
<td>tab</td>
<td></td>
</tr>
<tr>
<td>question</td>
<td></td>
<td>space</td>
<td></td>
</tr>
<tr>
<td>exclamation</td>
<td></td>
<td>backspace</td>
<td></td>
</tr>
<tr>
<td>ampersand</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Editing

<table>
<thead>
<tr>
<th>Character</th>
<th>Stroke options</th>
<th>Character</th>
<th>Stroke options</th>
</tr>
</thead>
<tbody>
<tr>
<td>forward delete</td>
<td></td>
<td>paste</td>
<td></td>
</tr>
<tr>
<td>cut</td>
<td></td>
<td>undo</td>
<td></td>
</tr>
<tr>
<td>copy</td>
<td></td>
<td>carriage return</td>
<td></td>
</tr>
</tbody>
</table>

Using the number area

You can enter numbers, punctuation, and editing marks in the number area (123) of the input panel.

A horizontal line drawn from left to right is recognized as a space character in the letter area of the input panel and as a
dash in the number area.

### Numbers

<table>
<thead>
<tr>
<th>Character</th>
<th>Stroke options</th>
<th>Character</th>
<th>Stroke options</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>• • •</td>
<td>5</td>
<td>5 5</td>
</tr>
<tr>
<td>1</td>
<td>1 1 1</td>
<td>6</td>
<td>6</td>
</tr>
<tr>
<td>2</td>
<td>2 2 2</td>
<td>7</td>
<td>7</td>
</tr>
<tr>
<td>3</td>
<td>3 3 3</td>
<td>8</td>
<td>8 8</td>
</tr>
<tr>
<td>4</td>
<td>4 4 4</td>
<td>9</td>
<td>9</td>
</tr>
</tbody>
</table>

### Punctuation

<table>
<thead>
<tr>
<th>Character</th>
<th>Stroke options</th>
<th>Character</th>
<th>Stroke options</th>
</tr>
</thead>
<tbody>
<tr>
<td>period</td>
<td>•</td>
<td>/</td>
<td>/</td>
</tr>
<tr>
<td>comma</td>
<td>___</td>
<td>\</td>
<td>\</td>
</tr>
<tr>
<td>dash</td>
<td>•</td>
<td>(</td>
<td>(</td>
</tr>
<tr>
<td>tilde</td>
<td>N</td>
<td>)</td>
<td>)</td>
</tr>
<tr>
<td>*</td>
<td>&quot; &quot;</td>
<td>=</td>
<td>=</td>
</tr>
<tr>
<td>*</td>
<td>&quot; &quot;</td>
<td>backspace</td>
<td>—</td>
</tr>
</tbody>
</table>
Editing

<table>
<thead>
<tr>
<th>Character</th>
<th>Stroke options</th>
<th>Character</th>
<th>Stroke options</th>
</tr>
</thead>
<tbody>
<tr>
<td>cut</td>
<td></td>
<td>undo</td>
<td></td>
</tr>
<tr>
<td>copy</td>
<td></td>
<td>tab</td>
<td></td>
</tr>
<tr>
<td>paste</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Writing accented letters

To write an accented letter, write the letter in the letter area and the accent in the number area.

Accented letters

<table>
<thead>
<tr>
<th>Accent mark</th>
<th>Stroke options</th>
<th>Accent mark</th>
<th>Stroke options</th>
</tr>
</thead>
<tbody>
<tr>
<td>à</td>
<td>\</td>
<td>à</td>
<td>\N</td>
</tr>
<tr>
<td>á</td>
<td>\</td>
<td>á</td>
<td>\</td>
</tr>
<tr>
<td>â</td>
<td>\A</td>
<td>â</td>
<td>\O</td>
</tr>
</tbody>
</table>

Using the symbol panel

In the symbol panel, you can enter symbols and characters that can't be entered in the standard input panel.
<table>
<thead>
<tr>
<th>Character</th>
<th>Stroke options</th>
<th>Character</th>
<th>Stroke options</th>
<th>Character</th>
<th>Stroke options</th>
</tr>
</thead>
<tbody>
<tr>
<td>·</td>
<td></td>
<td>·</td>
<td></td>
<td>&amp;</td>
<td></td>
</tr>
<tr>
<td>&quot;</td>
<td></td>
<td>&quot;</td>
<td></td>
<td>&quot;</td>
<td></td>
</tr>
<tr>
<td>?</td>
<td></td>
<td>2</td>
<td></td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>$</td>
<td></td>
<td>$</td>
<td></td>
<td>$</td>
<td></td>
</tr>
<tr>
<td>%</td>
<td></td>
<td>%</td>
<td></td>
<td>%</td>
<td></td>
</tr>
<tr>
<td>/</td>
<td></td>
<td>/</td>
<td></td>
<td>/</td>
<td></td>
</tr>
<tr>
<td>\</td>
<td></td>
<td>\</td>
<td></td>
<td>\</td>
<td></td>
</tr>
<tr>
<td>=</td>
<td></td>
<td>=</td>
<td></td>
<td>=</td>
<td></td>
</tr>
<tr>
<td>+</td>
<td></td>
<td>+</td>
<td></td>
<td>+</td>
<td></td>
</tr>
<tr>
<td>:</td>
<td></td>
<td>:</td>
<td></td>
<td>:</td>
<td></td>
</tr>
<tr>
<td>;</td>
<td></td>
<td>;</td>
<td></td>
<td>;</td>
<td></td>
</tr>
<tr>
<td>=</td>
<td></td>
<td>=</td>
<td></td>
<td>=</td>
<td></td>
</tr>
<tr>
<td>Character</td>
<td>Stroke options</td>
<td>Character</td>
<td>Stroke options</td>
<td>Character</td>
<td>Stroke options</td>
</tr>
<tr>
<td>-----------</td>
<td>----------------</td>
<td>-----------</td>
<td>----------------</td>
<td>-----------</td>
<td>----------------</td>
</tr>
<tr>
<td>1</td>
<td><img src="1" alt="Image" /></td>
<td>#</td>
<td><img src="2" alt="Image" /></td>
<td>^</td>
<td><img src="3" alt="Image" /></td>
</tr>
<tr>
<td>{</td>
<td><img src="4" alt="Image" /></td>
<td>·</td>
<td><img src="5" alt="Image" /></td>
<td>$</td>
<td><img src="6" alt="Image" /></td>
</tr>
<tr>
<td>}</td>
<td><img src="7" alt="Image" /></td>
<td>£</td>
<td><img src="8" alt="Image" /></td>
<td>⚪</td>
<td><img src="9" alt="Image" /></td>
</tr>
<tr>
<td>Φ</td>
<td><img src="10" alt="Image" /></td>
<td>Ξ</td>
<td><img src="11" alt="Image" /></td>
<td>⚪</td>
<td><img src="12" alt="Image" /></td>
</tr>
<tr>
<td>α</td>
<td><img src="13" alt="Image" /></td>
<td>α</td>
<td><img src="14" alt="Image" /></td>
<td>...</td>
<td><img src="15" alt="Image" /></td>
</tr>
<tr>
<td>ζ</td>
<td><img src="16" alt="Image" /></td>
<td>ζ</td>
<td><img src="17" alt="Image" /></td>
<td>•</td>
<td><img src="18" alt="Image" /></td>
</tr>
<tr>
<td>η</td>
<td><img src="19" alt="Image" /></td>
<td>η</td>
<td><img src="20" alt="Image" /></td>
<td>–</td>
<td><img src="21" alt="Image" /></td>
</tr>
<tr>
<td>θ</td>
<td><img src="22" alt="Image" /></td>
<td>θ</td>
<td><img src="23" alt="Image" /></td>
<td>–</td>
<td><img src="24" alt="Image" /></td>
</tr>
<tr>
<td>ι</td>
<td><img src="25" alt="Image" /></td>
<td>ι</td>
<td><img src="26" alt="Image" /></td>
<td>•</td>
<td><img src="27" alt="Image" /></td>
</tr>
<tr>
<td>ι</td>
<td><img src="28" alt="Image" /></td>
<td>ι</td>
<td><img src="29" alt="Image" /></td>
<td>•</td>
<td><img src="30" alt="Image" /></td>
</tr>
<tr>
<td>i</td>
<td><img src="31" alt="Image" /></td>
<td>i</td>
<td><img src="32" alt="Image" /></td>
<td>$</td>
<td><img src="33" alt="Image" /></td>
</tr>
</tbody>
</table>

118 Hewlett-Packard Jornada 420 Palm-size PC
<table>
<thead>
<tr>
<th>Character</th>
<th>Stroke options</th>
<th>Character</th>
<th>Stroke options</th>
<th>Character</th>
<th>Stroke options</th>
</tr>
</thead>
<tbody>
<tr>
<td>b</td>
<td></td>
<td></td>
<td></td>
<td>g</td>
<td></td>
</tr>
<tr>
<td>p</td>
<td></td>
<td></td>
<td></td>
<td>a</td>
<td></td>
</tr>
<tr>
<td>d</td>
<td></td>
<td></td>
<td></td>
<td>l</td>
<td></td>
</tr>
<tr>
<td>θ</td>
<td></td>
<td></td>
<td></td>
<td>l</td>
<td></td>
</tr>
<tr>
<td>Ô</td>
<td></td>
<td></td>
<td></td>
<td>Ł</td>
<td></td>
</tr>
<tr>
<td>ô</td>
<td></td>
<td></td>
<td></td>
<td>Ö</td>
<td></td>
</tr>
<tr>
<td>β</td>
<td></td>
<td></td>
<td></td>
<td>Œ</td>
<td></td>
</tr>
<tr>
<td>µ</td>
<td></td>
<td></td>
<td></td>
<td>%</td>
<td></td>
</tr>
<tr>
<td>¥</td>
<td></td>
<td></td>
<td></td>
<td>+</td>
<td></td>
</tr>
</tbody>
</table>

**Simplified Uppercase Character Set**

You can choose to use this character set instead of the Natural Character Set by selecting it in the **CIC Jot Options** dialog box. This character set gives you fewer options for entering each character, as you're writing in uppercase only, but allows for greater flexibility in writing the letters, so you can write faster.

The tables in this section show how to use the Simplified Uppercase Character Set to write letters, numbers, punctuation...
marks, editing marks, and symbols. For each character, the tables show alternatives for writing the characters. The dots indicate where the strokes begin; strokes with no dots can be written in either direction. Where appropriate, the stroke sequence is numbered.

Using the letter areas

You can enter letters, punctuation, and editing marks in the letter areas (abc and ABC) of the input panel.

<table>
<thead>
<tr>
<th>Character</th>
<th>Stroke options</th>
<th>Character</th>
<th>Stroke options</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>*</td>
<td>P</td>
<td>P P</td>
</tr>
<tr>
<td>B</td>
<td>B B</td>
<td>Q</td>
<td>QQ</td>
</tr>
<tr>
<td>C</td>
<td>C</td>
<td>R</td>
<td>RR</td>
</tr>
<tr>
<td>D</td>
<td>D D</td>
<td>S</td>
<td>S</td>
</tr>
<tr>
<td>E</td>
<td>E</td>
<td>T</td>
<td>T T T</td>
</tr>
<tr>
<td>F</td>
<td>F F F F</td>
<td>U</td>
<td>U U</td>
</tr>
<tr>
<td>G</td>
<td>G G</td>
<td>V</td>
<td>V V V</td>
</tr>
<tr>
<td>H</td>
<td>H</td>
<td>W</td>
<td>W</td>
</tr>
<tr>
<td>I</td>
<td>I</td>
<td>X</td>
<td>X X X X</td>
</tr>
<tr>
<td>J</td>
<td>J</td>
<td>Y</td>
<td>Y Y</td>
</tr>
<tr>
<td>K</td>
<td>K K K K</td>
<td>Z</td>
<td>Z</td>
</tr>
</tbody>
</table>
### Editing

<table>
<thead>
<tr>
<th>Character</th>
<th>Stroke options</th>
<th>Character</th>
<th>Stroke options</th>
</tr>
</thead>
<tbody>
<tr>
<td>space</td>
<td></td>
<td>copy</td>
<td></td>
</tr>
<tr>
<td>back delete</td>
<td></td>
<td>paste</td>
<td></td>
</tr>
<tr>
<td>forward delete</td>
<td></td>
<td>undo</td>
<td></td>
</tr>
<tr>
<td>cut</td>
<td></td>
<td>carriage</td>
<td>return</td>
</tr>
</tbody>
</table>

### Using the number area

In addition to numbers, you can enter punctuation and editing marks in the number area (123) of the input panel.

A horizontal line drawn from left to right is recognized as a space character in the letter area of the input panel, and as a dash in the number area.
### Numbers

<table>
<thead>
<tr>
<th>Character</th>
<th>Stroke options</th>
<th>Character</th>
<th>Stroke options</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>○○</td>
<td>5</td>
<td>55</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>6</td>
<td>6</td>
</tr>
<tr>
<td>2</td>
<td>2</td>
<td>7</td>
<td>*</td>
</tr>
<tr>
<td>3</td>
<td>3</td>
<td>8</td>
<td>88</td>
</tr>
<tr>
<td>4</td>
<td>444</td>
<td>9</td>
<td>9</td>
</tr>
</tbody>
</table>

### Punctuation

<table>
<thead>
<tr>
<th>Character</th>
<th>Stroke options</th>
<th>Character</th>
<th>Stroke options</th>
</tr>
</thead>
<tbody>
<tr>
<td>(</td>
<td>(</td>
<td>/</td>
<td>/</td>
</tr>
<tr>
<td>)</td>
<td>)</td>
<td>^</td>
<td>^</td>
</tr>
<tr>
<td>=</td>
<td>=</td>
<td>%</td>
<td>%</td>
</tr>
<tr>
<td>.</td>
<td>.</td>
<td>.</td>
<td>.</td>
</tr>
<tr>
<td>*</td>
<td>*</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Editing

<table>
<thead>
<tr>
<th>Character</th>
<th>Stroke options</th>
<th>Character</th>
<th>Stroke options</th>
</tr>
</thead>
<tbody>
<tr>
<td>undo</td>
<td>←•→</td>
<td>paste</td>
<td>←*</td>
</tr>
<tr>
<td>cut</td>
<td>¥</td>
<td>carriage return</td>
<td></td>
</tr>
<tr>
<td>copy</td>
<td></td>
<td>dash -</td>
<td>←</td>
</tr>
</tbody>
</table>

Writing accented letters
To write an accented letter, write the letter in the letter area and the accent in the number area.

Accented letters

<table>
<thead>
<tr>
<th>Accent mark</th>
<th>Stroke options</th>
<th>Accent mark</th>
<th>Stroke options</th>
</tr>
</thead>
<tbody>
<tr>
<td>à</td>
<td>\</td>
<td>à</td>
<td>\</td>
</tr>
<tr>
<td>á</td>
<td>/</td>
<td>ã</td>
<td>••</td>
</tr>
<tr>
<td>å</td>
<td>\</td>
<td>â</td>
<td>○</td>
</tr>
</tbody>
</table>

Using the symbol panel
In the symbol panel, you can enter symbols and characters that can't be entered in the standard input panel.

You can enter punctuation in the punctuation area (punct) and symbols in the symbol area (symb).
## Punctuation

<table>
<thead>
<tr>
<th>Character</th>
<th>Stroke options</th>
<th>Character</th>
<th>Stroke options</th>
</tr>
</thead>
<tbody>
<tr>
<td>period</td>
<td>•</td>
<td>&amp;</td>
<td>8 8</td>
</tr>
<tr>
<td>comma</td>
<td>/</td>
<td>^</td>
<td></td>
</tr>
<tr>
<td>apostrophe</td>
<td>′</td>
<td>&lt;</td>
<td>′</td>
</tr>
<tr>
<td>?</td>
<td>?</td>
<td>&gt;</td>
<td>&gt;</td>
</tr>
<tr>
<td>!</td>
<td>′</td>
<td>{</td>
<td></td>
</tr>
<tr>
<td>dash</td>
<td>←</td>
<td>}</td>
<td>3</td>
</tr>
<tr>
<td>underscore</td>
<td>←</td>
<td>$</td>
<td>$</td>
</tr>
<tr>
<td>/</td>
<td>/</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>\</td>
<td>\</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>(</td>
<td>)</td>
<td>%</td>
<td>%</td>
</tr>
<tr>
<td>)</td>
<td>)</td>
<td>TAB</td>
<td></td>
</tr>
<tr>
<td>=</td>
<td>Z</td>
<td>~</td>
<td>N</td>
</tr>
</tbody>
</table>
## Symbols

<table>
<thead>
<tr>
<th>Character</th>
<th>Stroke options</th>
<th>Character</th>
<th>Stroke options</th>
<th>Character</th>
<th>Stroke options</th>
</tr>
</thead>
<tbody>
<tr>
<td>!</td>
<td></td>
<td>z</td>
<td></td>
<td>p</td>
<td></td>
</tr>
<tr>
<td>@</td>
<td></td>
<td>x</td>
<td></td>
<td>b</td>
<td></td>
</tr>
<tr>
<td>#</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$</td>
<td>$</td>
<td>¼</td>
<td></td>
<td>ø</td>
<td></td>
</tr>
<tr>
<td>%</td>
<td>%</td>
<td>½</td>
<td></td>
<td>ø</td>
<td></td>
</tr>
<tr>
<td>&amp;</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>*</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>&quot;</td>
<td>&quot;</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>:</td>
<td>:</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>;</td>
<td>;</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>?</td>
<td></td>
<td>æ</td>
<td></td>
<td>=</td>
<td></td>
</tr>
<tr>
<td>*</td>
<td></td>
<td>æ</td>
<td></td>
<td>=</td>
<td></td>
</tr>
<tr>
<td>Character</td>
<td>Stroke options</td>
<td>Character</td>
<td>Stroke options</td>
<td>Character</td>
<td>Stroke options</td>
</tr>
<tr>
<td>-----------</td>
<td>----------------</td>
<td>-----------</td>
<td>----------------</td>
<td>-----------</td>
<td>----------------</td>
</tr>
<tr>
<td><code>&quot;</code></td>
<td></td>
<td><code>œ</code></td>
<td></td>
<td><code>&quot;</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td><code> </code></td>
<td></td>
<td><code> </code></td>
<td></td>
<td><code>ø</code></td>
<td></td>
</tr>
<tr>
<td>Character</td>
<td>Stroke options</td>
<td>Character</td>
<td>Stroke options</td>
<td>Character</td>
<td>Stroke options</td>
</tr>
<tr>
<td>-----------</td>
<td>----------------</td>
<td>-----------</td>
<td>----------------</td>
<td>-----------</td>
<td>----------------</td>
</tr>
<tr>
<td>†</td>
<td></td>
<td>‟</td>
<td></td>
<td>․</td>
<td></td>
</tr>
<tr>
<td>†</td>
<td></td>
<td>Ġ</td>
<td></td>
<td>․</td>
<td></td>
</tr>
<tr>
<td>...</td>
<td></td>
<td>Š</td>
<td></td>
<td>․</td>
<td></td>
</tr>
</tbody>
</table>
Hewlett-Packard Jornada 420 Palm-size PC
B | Migrating data from non–Windows CE HP handheld PC devices

If your data is stored on an HP 100/200LX Palmtop PC or an HP OmniGo Organizer, you must first transfer the data to your desktop PC. Use the Hewlett-Packard PIM Translation Utility (for HP devices only) to import the data into Microsoft Outlook or Schedule+ 7.0a on your desktop PC. After you have imported the data into Outlook or Schedule+, you can update the information on your HP Jornada by synchronizing with Outlook or Schedule+ using Windows CE Services 2.2.


This procedure migrates only Appointment Book and Phone Book data. Before translating PIM data files, you must install the version of Schedule+ 7.0a found on the Desktop Software for Microsoft Windows CE compact disk on your desktop PC.

You can translate only one file at a time. To translate multiple PIM data files, you need to repeat the Translation operation for each file separately.

Translating appointment data

Although daily, weekly, monthly, and yearly repeated events are supported in the Appointment Book applications on the HP 100LX/200LX palm-size PCs and HP OmniGo 100/120 organizers and in the Calendar application on the HP Jornada, the Schedule+ application supports only daily and yearly repeated events. Because all translation goes through Schedule+, no direct mapping is available from the older device to Schedule+.
for repeating weekly and monthly events. As long as you do not edit imported repeating weekly or monthly events in Schedule+ before you synchronize them with the HP Jornada, they translate correctly into repeating events on the HP Jornada. If, however, you edit them in Schedule+, they lose their weekly/monthly attribute and are treated as single events.

To translate appointment data
1. Double-click the HP PIM Translation Utility icon to start the program.
2. In the Welcome screen, click Appointments.
3. In the Open File dialog box that appears, specify the appointment data file to translate, and then click OK. If the file you specify is not a PIM database file of the appropriate type, you get an error message.
4. In the Appointment Book Translation Note screen, click OK. The Data Translation Progress screen appears, showing the progress of current translation activity.
5. When the translation has successfully completed, a message appears. Click OK to return to the Welcome screen.

Translating Phone Book data
This section describes how to translate Phone Book data, and describes Phone Book field mapping and how to modify it.

To translate a Phone Book data file
1. Double-click the HP PIM Translation Utility icon to start the program.
2. In the Welcome screen, click Phone Book.
3. In the Open File dialog box, specify the phone book data file to translate, and then click OK.
4. In the Phone Book Translation Field Map window, select mapping options. For more information, see the sections below.

5. When translation is complete, a message appears. Click OK to return to the Welcome screen.

Phone Book field mapping

The HP PIM Translation Utility attempts to map the fields in your Phone Book data file to standard fields in a Schedule+ record. As long as your Phone Book fields have standard names (that is, you have not modified the Phone Book database field structure), the translation is straightforward. The suggested mapping appears in a table in the Phone Book Translation Field Map screen:

- The left column shows the names of fields extracted from the Phone Book data file. (Only the fields that have data are included.)
- The right column shows the names of Schedule+ fields.
- An arrow in the center column indicates that the data in a Phone Book field in the left column is copied to the corresponding Schedule+ field in the right column. Note that multiple Phone Book fields (for example, Address1 and Address2) can be mapped to the same Schedule+ field (for example, Business address). No arrow in the center column indicates that there is no mapping and, therefore, the data is not copied.

You can add or modify the suggested mappings before translating the data. For example, if you have customized the name of a Phone Book field so that the HP PIM Translation Utility does not know how to map it, you can define a mapping for it yourself.

Name mapping

The Name field in the Phone Book data file can be mapped in three ways in Schedule+:

- If the name in the Phone Book data file is entered as Name1, Name2 [Name3] (that is, with a comma after the first word), it
is always mapped to the two name fields in Schedule+ with Name1 = Last Name and Name2 [Name3] = First Name.

- If the name in the Phone Book data file does not have a comma after the first word, you can choose one of two options for its mapping:
  - Last name/First name - (default) Name1 [Name3] Name2 maps to Name1 = Last Name and [Name3] Name2 = First Name.
  - First name/Last name - Name1 [Name3] Name2 maps to Name1 [Name3] = First Name and Name2 = Last Name.

In all cases, Last name is mapped to a single word, with any additional words such as [Name3] becoming part of First name.

Mapping additions

If a field appears in the left column with no mapping (that is, no arrow in the center column) select a field name from the dropdown list of the Schedule+ field immediately to the right of the field whose mapping you want to define. The field name appears in the appropriate cell in the right column and a mapping arrow appears in the center column.

Mapping changes

If a field in the left column is mapped to the wrong field in the right column, change the mapping by selecting a different Schedule+ field name from the dropdown list for the corresponding cell in the right column.

Mapping removal

If a field in the left column should not be mapped to anything, click None from the dropdown list for the corresponding cell in the right column. The None option is not available for the Name field. Translation status review After each translation is finished, whether it completed successfully or was interrupted, the results are written onto the Status screen. Click the Status button on the Welcome screen to see the history of any translations begun during the current execution of the HP PIM Translation Utility.
## Index

### A

- **AC adapter**
  - connecting, 14
- **AC Charging LED**, 8
- **accessories**
  - adding, 91
- **action button**, 9
- **Active Desktop**, 23
- **ActiveSync**, 39, 50
- **adding**
  - desktop wallpaper, 90
  - programs from the HP Jornada compact disk, 88
  - programs with Application Manager, 88
- **sounds**, 90
- **address book**, 70
- **adjusting**
  - button assignments, 30
  - owner, 30
  - password, 30
  - power, 30
  - settings, 30
  - system, 30
  - volume & sounds, 30
- **World Clock**, 30
- **Application Manager**
  - installing programs with, 88
- **automatic connection**, 46

### B

- **backing up data**
  - using HP Jornada backup, 84
  - using Microsoft Windows CE Services, 83
- **battery**
  - conserving power, 19
  - installation, 11
  - managing power, 16
  - power control panel, 16
  - viewing status, 33
- **brightness**
  - adjusting, 31, 32
- **browsing**
  - HP Jornada desktop, 49
- **bTask**, 82
- **buttons**
  - action, 9
  - close, 17
  - exit, 9
  - locking, 22
  - power on/off, 9, 21
  - record, 9
  - release, on cradle, 13
  - reset, 10
  - start, 9
  - unlocking, 22

### C

- **Calendar**
  - using, 68
- **caring for the HP Jornada**, 20
channels
  about, 52
  personalizing, 53
  synchronizing, 53
  viewing content, 53
character recognition, 27
close button, 17
closing the connection to a
desktop PC, 47
command bar, 25
CompactFlash cards
  inserting and removing, 92
  locating the slot, 10
CompuServe
  sending and receiving e-
  mail, 65
conflicts
  synchronization, 52
connecting
  AC adapter, 14
  automatically to a
desktop PC, 46
  by infrared to a desktop
  PC, 47
  manually to a desktop
  PC, 46
  to a desktop PC by sync
  cable, 42
  to a non-partner PC, 48
  to an Internet service
  provider, 60
connecting via Ethernet, 60
Contacts
  using, 70
contrast
  adjusting, 31, 32
cradle
  release buttons, 13
  using, 13
customizing HP Jornada
desktop wallpaper, 90
  sounds, 90, 91
  third-party software, 86
D
DC jack, 14
deleting
  characters, 28
desktop PCs
  connecting to, 46
  disconnecting from, 47
dial-up connections
  setting up, 59
  disconnecting from a
desktop PC, 47
displaying
  channel content on the
desktop, 54
  information on the
desktop, 23
  mobile desktop
  components, 54
drawing, 77, 79
E
editing
  drawings, 79
text, 79
e-mail
  connecting to an Internet
  service provider, 60
  enabling synchronization,
  55
  getting accounts with
  Internet service
  providers, 58
  setting up a dial-up
  connection, 59
  synchronizing, 55
  using dial-up connections
to send and receive, 57
  using Windows CE Inbox
  Transfer to transfer, 56
establishing
  partnerships, 43
Ethernet connections, 60
exit button, 9
EzExplorer, 28
F
file conversion, 51
files
   finding, 28
finding information, 29
freeware, 41
full reset, 100

G
games
   Solitaire, 4

H
hard icons
   locating, 9
   reconfiguring, 22
   using, 22
hard reset. See full reset
HP Jornada
   browsing the desktop, 49
   caring for, 20
   turning on and off, 21
HP Jornada compact disk
   contents of, 87
   installing programs from, 88
   minimum PC requirements, 87
HP settings
   adjusting brightness,
      contrast, volume, 31
   password delay timer, 35
   setting a password, 35
   using, 31
   viewing battery status, 33
   viewing memory status, 34

I
Inbox
   receiving e-mail, 62
   sending and receiving
      CompuServe e-mail, 65
   sending e-mail, 64
   using, 61
infrared
   connecting, 47
infrared port, 8
installing
   battery, 11
   programs from the HP Jornada compact disk, 88
   programs with
      Application Manager, 88

L
LEDs
   AC Charging, 8
   notification, 8
   list view, 29
   locking the hardware buttons, 22

M
managing battery power, 16
manual connection, 46
memory
   adjusting allocation, 34
   viewing status, 34
microphone, 8
Microsoft Windows CE
   Services
      about, 39
      contents of compact disk, 40
   installing, 42
   minimum PC requirements, 41
   modems, 58
N
New Partnership Wizard, 44
Note Taker editing and formatting, 79
saving notes, 81
using, 77
writing and drawing, 79
notification LED, 8

O
OmniSolve calculator, 83
organizing notes, 82

P
partnerships establishing, 43
troubleshooting, 45
password delay timer, 35
setting, 35
playing recordings, 73
power control panel using, 16
power on/off button, 9, 21
printing, 54

R
record button, 9
recordings fast-forward, 73
formats, 75
making, 72
memory use, 74
organizing, 75
playing back, 73
rewinding, 73
skipping parts, 74
release buttons on cradle, 13
reminders, 71
removing programs, 89
with Application Manager, 89
with the Remove Programs control panel, 89
reset button, 10
resetting full, 100
soft, 99
resolving synchronization conflicts, 52

S
saving notes, 81
scheduling appointments, 68
serial port, 14
setting up a dial-up connection, 59
settings adjusting, 30
shareware, 41
shortcuts, 36
soft reset, 99
Solitaire, 4
sounds adding, 90
start button, 9
Start menu, 24
support, 105
suspend, 18
sync cable connecting P/PC to desktop PC, 42
synchronization conflicts, 52
synchronizing, 50
channels, 53
specifying data, 51

T
taskbar, 24
Tasks using, 71
third-party software, 86
tips, 36
transferring files, 54
troubleshooting partnerships, 45
viewing problems, 98
turning the HP Jornada on and off, 21
typing with the keyboard, 26

U
unlocking the hardware buttons, 22

V
viewing channel content, 53

W
information, 29
Voice Recorder using, 72
volume adjusting, 31
wallpaper adding, 90
warranty, 103
Welcome Wizard, 15
Windows CE Services. See Microsoft Windows CE Services
writing, 77, 79
writing with the Jot Character Recognizer, 27
Important: Please carefully read this License Agreement before operating the equipment. Rights to the software are offered only on the condition that the Customer agrees to all terms and conditions of the License Agreement. Operating the equipment indicates your acceptance of these terms and conditions. If you do not agree to the License Agreement, you may return the unopened package for a full refund. In return for payment of the applicable fee, HP grants the Customer a license to the software, until terminated, subject to the following:

**Use**
- Customer may use the software on any one computer.
- Customer may not reverse, assemble, or decompile the software.

**Copies and adaptations**
- Customer may make copies or adaptations of the software:
  - for archival purposes, or
  - when copying or adaptation is an essential step in the use of the software with a computer so long as the copies and adaptations are used in no other manner.
- Customer has no other rights to copy unless Customer acquires an appropriate license to reproduce which is available from HP for some software.
Customer agrees that no warranty, free installation, or free training is provided by HP for any copies or adaptations made by Customer.

All copies and adaptations of the software must bear the copyright notice(s) contained in or on the original.

Ownership
Customer agrees that they do not have any title or ownership of the software, other than ownership of the physical media.
Customer acknowledges and agrees that the software is copyrighted and protected under the copyright laws.
Customer acknowledges and agrees that the software may have been developed by a third-party software supplier named in the copyright notice(s) included with the software, who shall be authorized to hold the Customer responsible for any copyright infringement or violation of this License Agreement.

Transfer of rights in software
Customer may transfer rights to the software to a third party only as part of the transfer of all their rights and only if Customer obtains the prior agreement of the third party to be bound by the terms of this License Agreement.
Upon such a transfer, Customer agrees that their rights to the software are terminated and that they will either destroy their copies and adaptations or deliver them to the third party.
Transfer to a U.S. government department or agency or to a prime or lower tier contractor in connection with a U.S. government contract shall be made only upon prior written agreement to terms required by HP.

Sublicensing and distribution: Customer may not sublicense the software or distribute copies or adaptations of the software to the public in physical media or by telecommunication without the prior written consent of HP.

Termination: HP may terminate this software license for failure to comply with any of these terms, provided HP has requested Customer to cure the failure and Customer has failed to do so within thirty (30) days of such notice.
Updates and upgrades: Customer agrees that the software does not include updates and upgrades that may be available from HP under a separate support agreement.

Export clause: Customer agrees not to export or re-export the software or any copy or adaptation in violation of the U.S. Export Administration regulations or other applicable regulations.

HP shrink-wrap license terms

The following License Terms govern your use of the accompanying Software unless you have a separate signed agreement with HP.

License grant: HP grants you a license to use one copy of the Software. “Use” means storing, loading, installing, executing or displaying the Software. You may not modify the Software or disable any licensing or control features of the Software. If the Software is licensed for “concurrent use”, you may not allow more than the maximum number of authorized users to use the software concurrently.

Ownership: The Software is owned and copyrighted by HP or its third party suppliers. Your license confers no title to, or ownership in, the Software and is not a sale of any rights in the Software. Third party suppliers to HP may protect their rights in the event of any violation of these License Terms.

Copies and adaptations: You may only make copies or adaptations of the Software for archival purposes or when copying or adaptation is an essential step in the authorized Use of the Software. You must reproduce all copyright notices in the original Software on all copies or adaptations. You may not copy the Software onto any public network.

No disassembly or decryption: You may not disassemble or decompile the Software unless prior written consent is obtained from HP. In some jurisdictions, consent from HP may not be required for limited disassembly or decompilation. Upon request, you will provide HP with reasonably detailed information regarding any disassembly or decompilation. You may not decrypt the Software unless decryption is a necessary part of the operation of the Software.

Transfer: Your license will automatically terminate upon any transfer of the Software. Upon transfer, you must deliver the Software, including any copies and related documentation, to the
transferee. The transferee must accept these License Terms as a condition to the transfer.

Termination: HP may terminate your license upon notice for failure to comply with any of these License Terms. Upon termination, you must immediately destroy the Software, together with all copies, adaptations, and merged portions in any form.

Export requirements: You may not export or re-export the Software or any copy or adaptation in violation of any applicable laws or regulations.

U.S. government restricted rights: The Software and Documentation have been developed entirely at private expense. They are delivered and licensed as “commercial computer software” as defined in DFARS 252.227-7013 (Oct 1988), DFARS 252.211-7015 (May 1991) or DFARS 252.227-7014 (Jun 1995), as “commercial item” as defined in FAR 2.101 (a), or as “Restricted computer software” as defined in FAR 52.227-19 (Jun 1987) (or any equivalent agency regulation or contract clause), whichever is applicable. You have only those rights provided for such Software and Documentation by the applicable FAR or DFARS clause or the HP standard software agreement for the product involved.